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What is GEAR?

Elektroson's GEAR ™ product family is a pre-mastering and CD-Recordable package that supports all
aspects of Compact Disc indexing and production.

Formats supported include:

- CD-ROM - CD-ROM Mixed Mode
- CD-ROM XA - Multi Session
- CD Digital Audio - CD-i (Compact Disc Interactive)
- CDTV - EB (XA) - Electronic Book
- MMCD - HFS (Hierarchical File System)
- Photo CD - 3DO
- Video CD

If you choose CD-ROM or any of its derived products as the distribution and storage medium for your
information, then you need GEAR to produce it. GEAR fills the gap between your application on hard disk 
and    your application on CD-ROM.
With GEAR you can:

- Format your data files into a CD-ROM image that conforms to    the ISO-9660 standard. Versions 
are also available for MS-DOS, Apple Macintosh, Sun, HP9000 and other platforms. Unix 
versions have support for the Rock Ridge standard as well.

- Write a CD-R disc on any of the available CD-R recorders, including Sony, Philips, Kodak, 
Pioneer, Ricoh, Plasmon, JVC and Yamaha. The CD-R discs produced with GEAR are fully 
compatible with normally mastered CDs.

- Create a pre-master tape on 8 mm Exabyte, 9 track tape or 4 mm DAT for CD reproduction; 
optionally in DDP-format.

For each step GEAR offers the right solution.



What Do I Need to Know About CDs?
Before you start production, it is important and helpful that you understand the following concepts of CD 
and CD-R.

Multi Session
According to the Orange Book, Multi Session is the possibility to record the information on the CD-R in 
several interrupted actions (sessions) i.e. at a different time on a different recorder. Each session can 
contain information according to one of the CD standards (ISO, XA, DA, etc.). The data in different 
sessions can be linked i.e. a newer session can refer to data in an older session.

This functionality offers enormous possibilities for:
- document archiving
- updating catalogs of information regularly

Each session will introduce a data overhead (lead in and lead out) of 15 megabytes. This limits the 
number of sessions on a disc to about 40 (for a 650 Mb disc).

A true Multi Session CD-ROM reader will automatically go to the last session and present all linked 
sessions as one. As a user you will never be aware of the number of sessions on the disc.

GEAR fully supports the creation of Multi Session discs. If you want to append a session to a CD-R disc, 
GEAR reads back the last session and creates a virtual image of it. This image can then used as any 
other image to add, delete and update information. If you delete information from a session, the reference
to the data is deleted; the actual data remains on the session. When you write the new session to the disc
only the changes are written.

Multi Volume
Multi Volume discs use the same principle as a Multi Session disc. There is however an important 
difference; when writing Multi Volume discs, each ‘session    or Volume on the disc has no reference to 
another volume on the disc. Each volume can be seen as a separate CD. In order to read a Multi Volume 
disc you need a specific device driver which allows you to select a volume on the CD-R. Currently there 
are several third party software packages with this functionality.
GEAR fully supports the creation of Multi Volume discs. If you want to add a volume to a disc, just create 
the volume as any other volume (with the New option in the Session menu). When the image is ready just
put the CD-R disc you want to add the volume to in the recorder, and write the new volume.

Tracks
- A CD-R can contain up to 99 tracks, regardless of the number of sessions or the type of

tracks on the disc. GEAR allows you to create up to 99 tracks (Multi Media version only).
- It is not possible to have both ISO and XA tracks on the same session or virtual volume.
- In most cases only a Multi Session player can play an audio track on a Multi Session disc.

Not all    audio CD players can handle Multi Session audio discs.
- Each session or virtual volume always contains at least one track; Refer to the table below for

the possible track structures for a session or virtual volume:

Possible track structures

Number of tracks
ISO XA DA

Structure 1 1 - Up to 98
Structure 2 - 1 Up to 98
Structure 3 - - Between 1 and 99

Structures 1 and 2 can be used for each session of a Multi Volume or Multi Session disc. However, the 



maximum number of tracks for the whole disc is still 99. Structure 3 should not be used for Multi Session 
discs. Structure 3 should not be used for Multi Session discs. There is, however, another structure 
enabling the use of audio tracks in combination with Multi Session called `CD Extended' or `CD Plus'. 
These CD-Rs have multiple audio tracks in the first session and use the subsequent sessions for data. 
This means that an audio player only `sees' the first session (i.e. audio tracks), whereas a Multi Session 
CD-ROM player only presents the data sessions.        

Incremental Write
Incremental Write is the possibility to divide a data track into small data packets and write each data 
packet separately to a CD-R disc. For Incremental Writing there are two requirements:

- The CD-Recorder and software must support Incremental Write (refer to your CD-Recorder 
manual). GEAR supports Incremental Write. Most CD-Recorders do NOT support Incremental 
Write

- The ISO 9660 file system standard has to be extended. The ISO 9660 standard does not support 
Incremental Write. There is however a new (European) standard, ECMA 168, which is an 
extension of the ISO 9660 standard and which describes the necessary enhancements required 
for the support of Incremental Write. Support for the new ECMA 168 standard will be available in 
future releases of GEAR.

The packet size determines the amount of overhead. For a 64 Kb packet size. the overhead is about 
15%. A special driver is required to read incrementally written discs. Most CD-ROM readers currently on 
the market can not read an incrementally written disc!

CD-Recorders
CD-Recorders are computer peripherals with some very specific aspects. When a recorder is writing data 
to a disc, it cannot wait for the data (unlike for instance a tape unit). The data buffer of the recorder must 
always contain data.

Data transfer can only be stopped at very specific points. These points are determined by the way the 
disc is written (Disc at once, track at once or incremental). At these points (end of disc, end of track and 
end of packet) the recorder can finalize the writing of data and then the writing can be resumed at a later 
time. If the recorder cannot finalize the disc because it runs out of data unexpectedly, the CD-R disc is 
wasted and can not be used. Therefore, the data transfer rate to a CD-Recorder is very important! To 
minimize the chances of an unexpected data underrun, you could use Incremental Writing. However, 
Incremental Writing is not yet supported by CD-Recorders.

GEAR allows you to do a performance check on your system to check the transfer rate before data is 
written. We advise you to do this until you are very familiar with the possibilities of your system. 
GEAR also supports the so-called ‘test mode    of CD-Recorders. In this mode all data is transferred, but 
the disc is not actually written. This allows you to check your system performance for writing discs. When 
you start with CD-Recording , we advise you to use this test option for the first few discs. This allows you 
to get to know the software and the hardware, and also prevents you from wasting CD-R discs.

Single Session
Single Session discs usually contain one session. Once a volume is written as Single Session (by 
disabling the GEAR Multi Session option) no more data can be added to the disc. This can be used to 
'finalize' a Multi Session disc so that nobody can ever add data to the disc, or to create a disc with only 
one session.



Data Formatting (Generation)
Three windows appear when you start the software; the GEAR Working Window , the GEAR Status 
Window, and the New imagefile Window.

The Status Window indicates what GEAR is currently doing. The nine status fields of the Status Window 
display useful information about the CD-image you are working on, such as selected volume, selected 
track within the volume or selected directory.

The New imagefile Window allows you to create a new virtual image file; just type in a name for your new 
virtual image file and click OK. The    Create track window opens. Click on Create and select the ISO 
format. Click on Cancel to close the Create track window.

The virtual image file is created and the File Manager appears. You are now ready to start loading your 
data!

Files or directories are copied to the virtual image file simply by selecting them in the File Manager 
Window and dragging them to the GEAR Working Window.

Important
File Manager does not allow you to drag icons from its tree window (on the left); you can only use the 
directory window on the right. Just select a few files and/or directories and drag them to the GEAR 
Working Window.

Directly after you drop the selection, GEAR starts loading. The GEAR Status Window will show you which
files are loaded under which name and at which location. 



An ISO file or directory name is limited to 30 characters; valid characters are 0...9, A...Z and the 
underscore ‘_    (refer to Appendix A for further information). GEAR gives you a warning if there are any 
invalid characters in the file name. You can then choose to translate the file name to an ISO compliant 
name or you can leave the file name unchanged. GEAR has several options for handling non-ISO names.
Chapter 4 explains all these options.

After every file and directory has been loaded, the structure of the image can be verified in the GEAR 
Working Window. This window shows all files and directories present in the root directory of virtual image 
file. You can browse through your virtual image file just like you would do with a directory tree in the File 
Manager.

At this stage your ISO formatting is completed! There are no additional formatting actions required. You 
are ready to write your image to CD-R disc and/or premaster tape!

Multi Session Formatting
If you want to append data to a Multi Session disc you must first use the GEAR software to read back the 
last session on the disc. 

Important
The last session can only be read back if the disc was written with the Multi Session option enabled!

Put the disc in the recorder, start GEAR and choose    Append    from the    Session    menu. After selecting 
the    Append    option, select a session number (default is the last session on the disc). The selected 
session on the CD-R disc is read and a volume is created which contains the complete directory/file 
structure of the this session. This image will have the same name as the selected session on the disc. If 
the virtual image of this session is still present or another virtual volume with the same name is present, 
GEAR will give you a warning and will ask if it should overwrite the virtual volume. If you don't want to 
overwrite it you can use another working directory for creating the new session.

The data structure is displayed in the GEAR Working window. Files and directories can now be added in 
exactly the same way as for any other image. All files/directories belonging to the original session are 
colored differently than files added to the new session.



CD-R Writing
You can write the volume to disc by using the CD-R option of the Write menu or the disc icon of the 
toolbar.

Before writing to CD-R it is advisable to change the CD-R settings first

1. Select the Settings option from the Options menu.

2. Select the CD-R option; the CD-R settings dialog will appear. If you want to write a Multi Session 
disc, make sure that the Multi Session option is enabled.

3. Disable the writing of the CD-R disc by clearing the Recording enabled check box. This prevents
you from wasting a disc due to data transfer problems. You can also check what other settings
will be used by GEAR for writing your image.
Click on OK.

4. Select the CD-R option of the Write menu or click on the disc icon in the toolbar

When CD-R writing has been initiated, GEAR optimizes your virtual image; the volume is resized to the 
minimum size that can contain all the information. Next, all files in the volume are verified; the actual size 
and time stamp of each file is compared to the size and time stamp at the time of loading. If there are any 
differences GEAR warns you, and you can update the changed files by reloading them. Differences occur
if files are changed after being loaded into the virtual image.

If verification is successful and the Estimate before write setting is enabled, GEAR checks the 
performance of your system. If the system performance is sufficient, GEAR continues with writing the 
disc, otherwise writing is aborted.

To improve the system performance you can either minimize the fragmentation on your hard disk with a 
disk optimization program, or you can use the physical image file of the volume (refer to section 7.2).

GEAR then checks the recorder. If there is no disc in the tray, you will be asked to load one: writing of 
your CD-R disc starts. During writing, the software reports the percentage of each track of the volume 
written in the GEAR Status Window.

When writing is complete, the disc is ejected automatically. Your disc is ready for testing in a CD-ROM 
drive!



Premaster Tape Writing
You can write the volume to disc by using the Premaster tape option of the Write menu or the tape icon of 
the toolbar.

When premaster tape writing has been initiated, GEAR optimizes your virtual image; the volume is 
resized to the minimum size that can contain all the information. Next, all files in the volume are verified; 
the actual size and time stamp of each file is compared to the size and time stamp at the time of loading. 
If there are any differences GEAR warns you, and you can update the changed files by reloading them. 
Differences occur if files are changed after being loaded into the virtual image.

If verification is successful GEAR continues with writing the tape. GEAR checks the tape unit. If there is 
no tape loaded you will be asked to put a tape in the unit and writing of your tape starts. During writing, 
the software reports the percentage of each track of the volume written in the GEAR Status Window.

If the Verify before write setting is enabled, GEAR compares the contents of the tape with the actual 
volume. This means that the complete tape is read back and the data is checked against the contents of 
your virtual image. If there are any differences GEAR warns you. After verifying the tape, or directly after 
the writing if you decided to skip the verify operation, the tape is ejected automatically. You can now send 
the tape to a CD-ROM mastering plant!



Configuration Required to Run GEAR
The Multi Media version of GEAR for Windows requires the following configuration (versions for DOS, 
Sun, HP9000 and MAC are also available. Contact your distributor for more information).

Computer: IBM AT or compatible; 386DX or 486 (486 advised).

Hard disk: 25 Mb free disk space.

Important
A fast hard disk with a fast controller (12 msec average access time or less) is recommended. Use only
hard disks that do not require thermal recalibration. If thermal recalibration occurs during CD-R writing,
the data stream stops and the disc is wasted!

Operating system: PC or MS-DOS 5.0 or higher.
Microsoft Windows 3.1 or higher.
Aspi4dos.sys driver, Aspi7dos.sys driver or CAM driver.

Memory: 4 Mb (8 Mb advised) RAM.
500 kb conventional memory.

Adapter cards: Adaptec SCSI card or any other interface card which is supported by the ASPI
or ASPI compatible driver.

Future domain card with CAM driver.

                                             The hard disk and CD-Recorder unit should be connected to separate SCSI 
controllers.

Recorders: JVC XR-W1001, XR-W2001
Kodak PCD200, PCD225, PCD600
Philips CDD521, CDD522
Plasmon RF4100
RICOH RS-9200CD
Sony CDW-E1/W1, CDW900E
Yamaha CDR100, PDS301
Pioneer DR-R504X
Pinnacle RCD-1000

"Config.sys" file: Files=20
Buffers=40
Device=aspi4dos.sys /d
(refer to the card installation manual)

Refer to your MS-DOS manual for help when editing the "config.sys" file.



Hardware Installation
This section indicates important considerations when installing hardware so that you can connect a 
premaster tape and/or CD-R unit. 

Important
Always consult the manufacturer's instructions before installing hardware. Problems encountered during 
installation are usually due to hardware installation and not due to GEAR.

Use the software supplied with the Adaptec 1540/1542 SCSI host adapter or any adapter supported by 
the Adaptec ASPI manager driver or compatible. GEAR has been successfully tested with the Buslogic, 
Future Domain and Bustek adapters. In all cases the adapter was tested with the ASPI software delivered
with the adapter. 

Important
We strongly advise NOT to use the same Adaptec board to control your hard disk and the CD-Recorder.

If you install a separate adapter for the CD-R unit, make sure the BIOS of this adapter is disabled, and 
check the address settings to prevent an address conflict with the hard disk adapter. The INT Request 
and DMA channel selection of the two adapters must be different to prevent conflicts.

If an adapter is already present in your computer,    you may have to change the interrupt channel, IO 
address and DMA channel select to prevent conflicts between the adapters.

Important
We strongly advise not to use different types of adapters in the same computer.

Adaptec 1540 and 1542 Adapters

If you use the Elektroson driver for the Adaptec 1540/1542 adapter and you have changed the settings on
the Adaptec adapter, check the settings in the GEAR.INI file.

The following settings for the Adaptec board controlling the CD-R unit, usually results in a working 
configuration:

- IO Address 230
- IRQ channel 15
- DMA channel 7

A conflicting hardware configuration might result in the following messages being displayed:

- Cannot write channel 2 buffer
- DMA test of AHA-154X board failed

Other error messages can result from an ASPI manager. If you are using an ASPI manager and errors 
occur, use another DMA channel and/or IRQ channel.

ASPI Managers

If you are using an ASPI manager as the device interface for multiple controllers and your CD-R unit is 
recognized by ASPI but not by GEAR, you will probably have to change the AspiHostAdapterNumber in 
the GEAR.INI file. If ASPI is installed for more than one adapter, the ASPI manager numbers each 
adapter,    starting from 0. The GEAR.INI entry defines which adapter GEAR should use for searching for 



the CD-R unit.

SCSI Adapters

The CD-Recorder can not always handle the high SCSI bus transfer rates that some of the new SCSI2 
controllers are using. This problem could cause 'miscompares' on CD-R discs. 

Previous controllers had a DMA transfer rate of 5.0 Mb/sec. SCSI2 controllers have a default transfer rate 
of 10 Mb/sec. Besides that, the new controllers use a type of 'sync negotiation' which is used to negotiate 
the synchronous data transfer rate. This 'sync negotiation' should be disabled for CD-Recorders because 
most of them cannot handle it adequately.

If 'miscompares' occur on a CD-R disc, you should check the following:
- type of controller used by the CD-Recorder
- DMA transfer rate used
- termination
- 'sync negotiation' enabled
- parity checking enabled

With Adaptec controllers you can check these settings by pressing <CTRL> A at boot time.

Medium Changers

Currently, GEAR supports 2 medium changers, the ASM Jukebox and the Kodak Disc Transporter. If a 
medium changer is being used, it must be connected to the same SCSI bus as the CD-Recorder. GEAR 
will use the medium changer only for automatic loading and unloading of the CD-R discs. The GEAR.INI 
entry UseMediumChanger must be set to TRUE if a medium changer is being used.



Software Installation
This section guides you through the installation of GEAR. We advise you to read chapter 2 after 
installation.

Warning
GEAR is delivered on one 3.5" diskette (includes the default GEAR.INI file). Unauthorized copying of the 
diskette is prohibited except for backup purposes. 

Additional copies of GEAR can be ordered. The diskette always contains the following files:

WINGEAR.EXE The GEAR main program
GEAR.IN_ The GEAR initialization file
WINGEAR.HL_ The GEAR help file
SETUP.EXE            The setup program

Additional files may be supplied with GEAR; these files are dependent upon the version of GEAR you 
have.

You need approximately 10 Mb of free space on the hard disk for installation of GEAR. GEAR takes up 
about 2 Mb of hard disk space after installation.

Important
Before installation:
- Make a backup copy of your GEAR software.
- If you want to use an ASPI or CAM driver install it.

1. Insert the GEAR diskette into your floppy disk drive. Windows must be running before you can
run the GEAR SETUP program. Click the    File    option of the Windows Program Manager and
select the    Run    command.

2. Type 'a:setup' in the    Command line    box (assuming your floppy disk drive is drive A) and click
on OK to confirm; the install program will begin.

A new directory for your GEAR software is created (default 'C:\GEARWIN'). The GEAR system files are 
copied to this new directory. You will also be asked to specify the GEAR working directory (default 'C:\
GEARIMG'). All files generated by GEAR are saved in this directory.

During installation the following files are modified.

WIN.INI file
The following lines are added the WIN.INI file:

[Gear for Windows]
GEARDIR=C:\GEAR

If you selected a directory name other than the default for the GEAR system files, the
'GEARDIR=' line is changed accordingly. 

SYSTEM.INI file
If you selected Elektroson's Adaptec device driver, the following lines are added to the
SYSTEM.INI file.

[386Enh]



DEVICE=GEARAHDR.386
GEARAHDR_IOADDRESS=330

If you selected the ASPI or CAM driver, the SYSTEM.INI file is not modified. If you want to
change from Elektroson's Adaptec driver to the ASPI driver or vice versa the software has to be
installed again!

GEARAHDR.386 file
The GEARAHDR.386 file is copied to the system directory of Microsoft Windows.

Important
If GEAR has to be installed again, remove the GEAR specific lines in the SYS TEM.INI and WIN.INI files.

The WIN.INI variable GEARDIR should be set correctly. If not, the software cannot locate the GEAR.INI 
file and initialization will fail. If you don't want to use the WIN.INI variable you can copy the GEAR.INI file 
to the GEAR working directory. GEAR notifies you if it cannot find the GEAR.INI file (for more information 
about the GEAR.INI file refer to Chapter 10).

The CONFIG.SYS and AUTOEXEC.BAT files are not affected by the installation of GEAR.



Locating and Opening an Existing Volume
An existing volume can either be a GEAR volume or an external volume. An external volume can not be 
edited but just written to CD-R disc and/or tape.

1. Click on Open CD-Image... in the File menu. The Open imagefile window displays a list of
available volumes in the current working directory.

2. To change the current directory select the relevant directory string from the    Directories    tree.

3. When the existing volume has been located double click on the volume name; a GEAR volume
is indicated by the ".vol" file extension.

Warning
Volumes of version 3.01 and earlier (with the .vtl extension) cannot be edited using version 3.2 and 
higher!

The previously selected volume (if any) is minimized and closed,    and the selected volume is opened. 
The first track of the volume opens automatically and its size is expanded to the maximum free space 
available within the volume. The maximum free space is dependent upon the maximum disc size 
specified when creating the volume and the memory required by the other tracks within the same volume.
The volume information is indicated in the GEAR Status window.

Closing the Current Volume

1. Click on Close CD-Image... in the File menu OR click on the relevant icon.

GEAR optimizes the Volume during closure; the current track is resized to the minimum size that can 
contain all the information. The information in the GEAR Status window is reset.

Deleting a Volume

Warning
Deleted volumes can not be restored. Use this command with care.

1. Click on    Delete CD-Image...    in the File menu. The    Delete imagefile window displays the
volumes available in the currently selected directory.



2. To change the current directory select the relevant directory string from the Directories tree.

3. When the volume has been located    double click on the volume name; a GEAR volume is
indicated by the    ".vol" file extension.

4. Confirm deletion of the volume by clicking on OK and then on Yes.

The related administration files and physical volume files are also deleted.



Creating a New Empty Virtual Volume
This will allow you to create and name a new empty virtual volume.

1. Click on New CD-Image... in the File menu.

2. Type in a name for your    new virtual volume. The name is limited to 8 characters; valid characters
are 0...9, A...Z and the underscore ‘_' (refer to Appendix B for further information).

Note
If you want to give your virtual volume a longer name you can use the Volume Descriptor option in the in 
the Edit menu (refer to Edditing a Volume Descriptor) 

3. GEAR creates a file by adding a suffix ‘.vol' to the virtual volume name. This file is called the virtual
volume administration file and is stored in the currently selected working directory. You can change
the working directory by using the Options menu.

Warning
Volumes of version 3.01 and earlier (with the .vtl extension) cannot be edited using version 3.2 and 
higher! 

4. Click on the Max. Disc Size menu and select the length of the virtual volume. The values 80, 74, 63
and 18 denote the virtual volume length in minutes and therefore determine the data capacity of the
virtual volume. When adding data, the GEAR status window allows you to check the remaining
space on the virtual volume. 

5. Click on OK to confirm creation of the new virtual volume.

Warning
GEAR cannot create a volume administration file if there is less than 25 Mb of free disk space. If the 
message ‘Volume administration files could not be created    is displayed you will have to create this free 
disk space.

Calculating virtual volume capacities
Data capacity = sector capacity (bytes) x length (mins) x 60 (secs) x 75 ( no. of sectors)

Sector capacities
ISO 2048 bytes
XA and CD-i 2336 bytes
CD audio 2352 bytes



Virtual volume capacities
ISO XA and CD-i CD audio

18 min 158 Mb 180 Mb 181 Mb
63 min 553 Mb 631 Mb 653 Mb
74 min 650 Mb 741 Mb 746 Mb
80 min 703 Mb 802 Mb 807 Mb

Note
A CD-Recorder always checks if there is enough space left for the Multi Session overhead. Depending on
the CD-Recorder this overhead is somewhere between 15 and 25 Mb. Therefore if you want to use all of 
the remaining memory for data, disable Multi Session.



Creating Tracks on a New Virtual Volume
When you have created a new virtual volume the Create track window menu appears. This menu allows 
you to add tracks to, and delete tracks from the virtual volume.

1. Select the required track type. The available track types are ISO, XA and CD audio. Click on 
Create to confirm. To add another track select Create and repeat this procedure. The Track
window displays the created tracks.

Notes
- The track number is automatically selected; this number is only relevant for CD audio, since ISO

and XA tracks are always assigned track number 1.
- A virtual volume can contain up to 99 tracks.
- It is not possible to have both ISO and XA tracks on the same virtual volume.
- It is not possible to assign CD audio to track number 1 if either an ISO or an XA track is selected

on the virtual volume.
- When a new track is created it is automatically assigned the maximum available space on the

virtual volume.



Selecting Track Contents
The content of each track is built up by selecting files/directories in the File Manager window and 
dragging them to the GEAR working window shown under the main menu.

1. Click on the required track and then click on Select. This track is automatically assigned the
maximum available space on the virtual volume. The track name is displayed in the GEAR status
window.

2. Use File Manager to drag and drop files to the GEAR working window.

Notes
- It is not possible to drag directories to a CD Digital Audio track.
- Data tracks only: the    NonISONameHandling    option of the    Generator Setup    window 
determines

how and when non ISO file and directory names are translated.



CD-Recorders
This section describes important installation and operational information that is specific to each of the CD-
Recorders supported by GEAR.

If an error occurs, an error message is displayed. The error message consists of a description plus an 
additional sense code. Sense codes are described in Appendix E.

If a buffer underrun occurs, GEAR always tries to unload the disc. If GEAR does not succeed in unloading
the disc we advise you to eject the disc manually.

JVC XR-W1001

This CD-Recorder can only write at single speed. It can perform a test run. Only the latest firmware (2.10)
from JVC supports Multi Session. GEAR only supports this version of firmware. Usually, GEAR will give 
you the following error message if you have the unsupported firmware:

ERROR: Illegal request for SCSI CD-Recorder. Additional sense code 24 (Hex)

If this happens, contact your dealer to upgrade your CD-Recorder.

The XR-W1001 has a very small internal buffer (64 kb) so a sustained data rate is very important.

Philips CDD521, Kodak PCD200

Both CD-Recorders are terminated internally. Therefore make sure that when you connect your CD-
Recorder it is at the end of the SCSI chain and without an external terminator. If you don't want the CD-
Recorder at the end of the chain remove the internal terminators! CD-Recorders which are terminated 
twice can cause problems.

Both CD-Recorders have a comparatively small buffer. If you want to write CD- ROM XA or CD Digital 
Audio check your system performance carefully. CD-ROM XA and CD Digital Audio images require a data
transfer rate which is about 15% faster than ISO!

Older firmware versions (below 2.x) cannot write at single speed or perform a test run; double speed 
writing is used regardless of the settings. Newer versions support single and double speed writing, and 
can perform a test run.
All versions support Multi Session.

Philips CDD522, Kodak PCD225

These CD-Recorders can write CD-R discs at single and double speed, support Multi Session and can 
perform a test run. The internal buffer size is 1 Mb, upgradable to 32 Mb. They are also capable of 
reading CD Digital Audio tracks via the SCSI bus, and are NOT terminated internally!
These recorders allow you to write 'Disc at once' besides 'Track at once'.

Pioneer DR-R504X

This CD-Recorder can write CD-R discs at single, double and quadruple speed. It supports Multi Session 
and can perform a test run. 



Plasmon RF4100
This CD-Recorder can write CD-R discs at single and double speed, supports Multi Session and can 
perform a test run. The internal buffersize is 1 Mb, upgradable to 32 Mb. It can NOT read CD Digital Audio
tracks via the SCSI bus.

RICOH RS-9200CD

Despite having a large internal buffer (1Mb), this CD-Recorder can only write at single speed. It supports 
Multi Session and can perform a test run.

Check the DIP switch settings carefully before connecting the CD-Recorder to prevent incorrect 
termination of the SCSI bus. The RS-9200CD may occasionally have difficulties reading the disc or 
getting on line. If this happens, switch the it off, wait a while and then switch it back on again. This will 
usually solve the problem.

At the time of printing, this was the only CD-Recorder supporting Incremental Writing.

SONY CDW-E1/W1, CDW900E

These CD-Recorders do not support Multi Session. Both CD-Recorders have a very large buffer (1-3 Mb).
Only the CDW900E can write at double speed. Neither CD-Recorder supports disc reading.

The CDW900E has both a hardware and a software switch for initialising a test run. We advise you to use
the software switch. Initialization for writing can last for 1.5 minutes.

The SONY CDW900E is one of the few CD-Recorders which can write subcode information to a CD-R 
disc.

You can connect up to 16 CDW900E (or 32 CDWE1/W1) CD-Recorders to the same SCSI controller; this 
allows you link 16 CD-Recorders together and write 16 discs in parallel!

YAMAHA PDS301

The PDS301 does not support Multi session and can not be used for disc reading. It supports single and 
double speed writing, and can perform a test run.

The PDS301 must always be the last CD-Recorder in the SCSI chain. Connect it to the SCSI bus through
SCSI port 2.

You can connect up to 14 PDS301 CD-Recorders to the same SCSI controller; this allows you to link 14 
CD-Recorders together and write 14 discs in parallel!

Yamaha advises the use of special TDK discs with the PDS301.

YAMAHA CDR-100

The CDR-100 can write CD-R discs at single, double and quadruple speed. It supports Multi Session and 
can perform a test run. If you want to use the quadruple speed option make sure you use the special 
quadruple speed (4x) medium to prevent problems. This is the only medium certified for quadruple speed 
writing.



It can read CD Digital Audio Tracks via the SCSI bus.

Firmware revisions 1.04 and higher allow you to write 'Disc at once' besides 'Track at once'. Also 1.04 
revisions allow you to write subcode information to your CD-R disc.



Editing Tracks
When you have selected new virtual volume the    Track    window appears. This window allows you to add
tracks, delete tracks, and select tracks so that the content can be edited.

1. Select the volume (refer to section 5.1) and click on Tracks... in the Edit menu.The Tracks
window presents a list of all existing tracks in the currently selected volume

2. Click on one of the following options:

Select
Selects an existing track for editing. When a track is selected, the previously selected track is 
optimized; resized to the minimum size that can contain all the information. The newly selected
track is assigned the maximum available space on the volume.

1. Click on    Select    in the    Track    window. The GEAR Working window is displayed. The
track information is displayed in the GEAR Status window. (Refer to section 5.3 for editing the
track contents.)

Create
Creates an empty track of a chosen type. The available track types are ISO, CD-ROM XA and 
CD Digital Audio.

1. Click on    Create    in the    Track    window.

2. Select the required track type. The available track types are ISO, CD-ROM XA and CD
Digital Audio. Click on Create to confirm. To add another track select Create and repeat this
procedure. The Track window displays the created tracks.

Notes
- The track number is automatically selected; this number is only relevant for CD Digital

Audio, since ISO and CD-ROM XA tracks are always assigned track number 1.
- A virtual volume can contain up to 99 tracks.
- It is not possible to have both ISO and CD-ROM XA tracks on the same virtual volume.



- It is not possible to assign CD Digital Audio to track number 1 if either an ISO or an
CD-ROM XA track is selected on the virtual volume.

- When a new track is created it is automatically assigned the maximum available space
on the virtual volume.

Important

Three administration files are created for each new track and located in the current working
directory. The name of these files consists of the first 8 characters of the volume name plus the
extensions    '.Mxx'    ,    '.Ixx'    and    '.Fxx'    ., where 'xx' stands for the track number. 

Information

If you need files on your hard disk that represent audio. These files must always fulfil the
following requirements (the so called Red Book format):

- Sample frequency must be 44.1 KHz.
- Audio must be stereo.
- Each sample must consist of 16 bits.
- The byte order must be the byte order used by the computer running the GEAR

software. If this is not the case the generic option MSBAudio= can be used so that
GEAR will swap the audio bytes for all tracks.

DOS/Windows: LSB audio default, with MSBAudio=true each track will be swapped by GEAR.

Depending on the audio package being used, the audio file may or may not contain a sound
header. You can also use the readtrack option of GEAR to copy a digital audio track from CD to
a file on hard disk. This option operates on the CDD522 and CDR100. The readtrack option
creates no header so the resulting file can be used directly.

Warning
The CDD522 reads audio in MSB format while the CDR100 reads audio in LSB format. The
current GEAR version supports Red Book audio files, WAV audio files and AIFF audio files. All
files should fulfil the above requirements. For WAV and AIIF files the header is automatically
removed.

AIFF files are usually in MSB format.

Warning
GEAR cannot create the Track administration files if there is less than 25 Mb of free disk space.
If the message ‘Track administration files could not be created' is displayed you will have to
create this free disk space.

You should never edit or delete these files manually: this will result in a corrupt and thus useless
volume. They will be deleted automatically when the associated volume is deleted!

Delete
Deletes the selected track. The related administration files and physical volume files are also
deleted. 

Warning
Deleted tracks can not be restored. Use this command with care.

Cancel
Closes the    Tracks    window.





Editing Track Contents
When a track has been selected (refer to section 5.2) you can edit it in the following ways:

- create a new directory on the track
- rename a file/directory on the track
- delete selected files/directories from the track
- select files/directories on the track
- de-select files/directories on the track

To Create a New Directory on the Track
First make sure you have selected the correct track.

1. Select the Files/Directories option from the Edit menu.

2. Select the    Create    option.

3. Type in the name of the new directory to be added to the track. 
The directory name is limited to 30 characters. Valid characters are 0...9, A...Z and the
underscore ‘_' (refer to Appendix A for further information). GEAR gives you a warning if there are
any invalid characters in the directory name. You can then choose to translate the directory
name to an ISO compliant name or you can leave the file name unchanged. GEAR has several
options for handling non-ISO names. Chapter 9 explains these options.

Note
- We advise you to limit the number of entries in a directory to 50.
- DOS can only handle names of up to 8 characters; files can have an extension of up to 3

characters.

Hiding the Directory
It is possible to create hidden directories by setting the    Hidden    option on before creating the
new directory.

1. Select    Options    from the GEAR main menu.
2. Select the    Settings    option.
3. Select the    Generation...    option. The    Generator Setup    window appears.
4. To hide new directories, toggle the    Hidden    box so that a cross is displayed. Press OK

to confirm.

To Rename a File/Directory on the Track
Renames the selected directory or file in the virtual data track to the new name. The name may not 
contain any other characters than uppercase A..Z, digits 0..9 and underscore ‘_    (refer to Appendix A).

1. Select the file(s) to be renamed. This can be done by:
EITHER
a. Clicking on the file with the mouse.
OR
b. Selecting the file(s) by using the    Select    option from the    Files/Directories    menu
(refer to section below - To Select Files/Directories on the track).

2. Select the      Files/Directories    option from the Edit menu and then the    Rename    option.

3. Type in the new name for the file and click on OK to confirm.

To Delete Selected Files/Directories from the Track



Deletes selected files/directories from the current track. A complete directory tree can be deleted without 
having to delete the files first!

1. Select the files/directories to be deleted. This can be done by:
EITHER
a. Clicking on the file with the mouse.
OR
b. Selecting the file(s) by using the    Select    option from the    Files/Directories    menu
(refer to section below - To Select Files/Directories on the track).

2. Select the      Files/Directories    option from the Edit menu and then the Delete option.

3. Confirm by clicking on OK.

To Select Files/Directories on the Track
This option lets the user enter a specification for selecting files/directories on the currently selected track. 
DOS wild-cards are allowed. This option is used for selecting a specific set of files/directories for deletion 
or renaming. Alternatively, the standard Windows method of file selection with the mouse can also be 
used.

1. Select the      Files/Directories    option from the Edit menu and then the    Select    option.

2. Type in the DOS string criteria for file/directory selection i.e. '*.txt' for all files with the 'txt'
extension. Confirm by clicking on OK.

To Deselect Files/Directories on the Track
This option lets the user enter a specification for deselecting files/directories on the currently selected 
track. DOS wild-cards are allowed. This option is used for selecting a specific set of files/directories 
previously selected for deletion or renaming. Alternatively, the standard Windows method of file selection 
with the mouse can also be used.

1. Select the      Files/Directories    option from the Edit menu and then the    Deselect    option.

2. Type in the DOS string criteria for file/directory deselection i.e. '*.txt' for all files with the 'txt'
extension. Confirm by clicking on OK.



Creating and Editing a Log
Creating
The GEAR batch utility allows you to RUN multiple GEAR commands without user interaction. The 
easiest way to create a batch file is to use the logging option of GEAR and create the image one time 
interactively. This is particularly useful if the same image has to be created but with an updated set of files
e.g. a CD which is published every quarter. All of the commands required for the creation of this image 
are saved in the log file. This log file can be used as a batch file without any editing.

You can also read the log file to check the image generation process. 

1. Start logging of the session by selecting the    Generate Log...    option from the    Session    menu.

2. The    Name of imagefile    window opens. An existing log file or a new log file can be used. If
logging is restarted during the same session with the same file name then the information will be
appended to the file, otherwise the existing file will be renamed. To change the current directory
select the relevant directory string from the    Directories    tree.

3. Click on OK to confirm the log file name; logging of the session starts

4. Stop logging of the session by selecting the    Generate Log...    option from the    Session    menu
again.

From log to batch file (editing)
A log file can be edited with any text editor and then used as a batch file. 

The contents of the log file could be as follows:

;New log file created at 1994 09 07    15:58
;Logging started.
;D:\GEARIMG
NEWVOL DEMO 74
;Volume DEMO created.
SELVOL DEMO 74
;Volume DEMO selected.
NEWTRK ISO 1
;Track 1 created.
COPYTREE D:\DATA DATA
;D:\DATA\FILE1.DAT
;Successfully loaded as: FILE1.DAT;1 at sector 169.
;Tree loaded.
COPYTREE D:\STARTUP STARTUP
;D:\STARTUP\INSTALL.EXE
;Successfully loaded as: INSTALL.EXE;1 at sector 200.
;Tree loaded.
;Log file closed at 1994 09 07    15:59

All lines preceded by a semicolon are ignored when running this log file as a batch file. You can add 
comments as long as they are preceded by a semi-colon. GEAR commands should start on a new line
Any of the commands as men tioned in Appendix G can be used.



Editing a Volume Descriptor
This option allows you to edit the information in the Primary Volume Descriptor for the currently selected 
volume. The default values are specified in the GEAR.INI file and can be changed with the    Generator    
option of the    Settings    menu. The content of the GEAR.INI file and the default values are explained in 
chapter 9.

1. Select the    Volume Descriptor...    option from the    Edit    menu. The Primary Volume Descriptor
window is displayed.

2. Type in the Volume Descriptor information for the currently selected volume. Click on OK to
confirm.

The following information can be edited:

    Volume Identifier
    System Identifier
    Publisher Identifier
    Data Preparer Identifier
    Application Identifier
    Application Use
    Copyright Identifier
    Abstract File Identifier
    Bibliographic File Identifier

Note
- This only affects the currently selected volume.



External Volumes
An external volume is a volume that has been generated by another indexing package. An external 
volume can not be edited by GEAR. However, it can be written by GEAR to a CD-R disc or to a premaster
tape. Before writing an external volume, it must be opened and the parameters defined.

1. Click on    Open...    in the    Session    menu. The    Open imagefile    window    displays a list of
available volumes in the current working directory.

2. Select the    External image file    option from the    Files of Type    list. All external volumes in the
currently selected directory are shown. To change the current directory,    select the relevant
directory string from the    Directories    tree.

3. When the required external volume has been located double click on the name. The    External
Volume Parameters    window is displayed. The previously selected volume (if any) is minimized
and closed,    and the selected external volume is opened. The external volume information is
indicated in the GEAR Status Window.

4. Select the format by:
- using the default format
- selecting a pre-defined format
- defining the format

Using the default format
Click on the    Default    button

Selecting a pre-defined format
From the    Image Type    list select one of the following pre-defined format:

Type Format
 1 CD-ROM mode 1 (ISO etc.) sector size 2048

2 CD-ROM mode 1 (ISO etc.) sector size 2352
 3 CD-ROM mode 1 (ISO etc.) sector size 2352, scrambled sectors with 2 seconds

pre-gap
 4 CD-ROM XA mode 2 sector size 2336
 5 CD-ROM XA mode 2 sector size 2352

6 CD-ROM XA mode 2 sector size 2352 scrambled sectors with 2 seconds pre-gap



7 CD-i mode 2 sector size 2336
8 CD-i mode 2 sector size 2352
9 CD-i mode 2 sector size 2352 with 2 seconds pre-gap
10 CD-i    mode 2 sector size 2352 scrambled sectors with 2 seconds pre-gap
11 Standard CD Digital Audio

External volume type
1 Standard ISO, HFS or CDTV image 
2 Standard ISO with EDC/ECC codes
3 ISO with EDC/ECC codes,    pre-gap and scrambled
4 Standard XA or EB XA (e.g. images with Mammoth XA streams)
5 Standard XA with EDC/ECC codes 
6 XA with EDC/ECC codes, pre-gap and scrambled
7 Standard CD-i without EDC/ECC codes
8 Standard CD-i with EDC/ECC codes
9 Standard CD-i with pre-gap
10 CD-i with    EDC/ECC codes, pre-gap and scrambled. Uses the same output format as

that of most CD-i authoring tools. 
11 Standard Audio

Notes
- The size of the pre-gap should always be 2 seconds (150 sectors). Scrambled images

must contain SYNC, HEADER and ECC/EDC code information. Unscrambled images
can be accepted with a 2352 sector size without the SYNC, HEADER and ECC/EDC
filled in.

- The byte order of audio files must be the byte order used by the computer running the
GEAR software. If this is not the case the generic option MSBAudio= of the GEAR.INI
file can be used so that GEAR will swap the audio bytes for all tracks.DOS/Windows:
LSB audio default, with MSBAudio=TRUE each track will be swapped by GEAR.
Audio files should NOT contain any sound header! If sound headers are not removed or
cleared, they will cause a sharp click in the resulting audio track on the CD. Audio files
should only contain 16 bit samples, stereo (one sample for the left channel and one
for the right channel) sampled on 44.1 kHz.

- The    External image files    option allows you to select only one file. If the external 
volume

consists of more than one file you can use the    Track list files    option to specify more
than one external file.

The track list file (*.tlf) contains one or more lines where each line specifies a track of the
CD-ROM (a full path can be used) e.g. to write a mixed mode image (contains one ISO track and
a number of digital audio tracks) the following lines can be specified in a track list file:

image.dat /1
audio.2      /11
audio.3      /11

Defining the format
From the    Image Type    list select    User defined image type. Set the parameters for the format.

5. Click on OK to confirm the format.



Appending Volumes to a Multi Session Disc
Append

GEAR allows you to append a new session to any session already existing on a multi-session CD-R disc. 
This powerful feature of GEAR allows you to:
- recover data from older sessions
- skip the last session if there are read errors on this session
- create `CD Extended' or `CD Plus' discs.

One of the sessions on the CD-R disc, to which the session is to be appended, is used as the basis of a 
new virtual image. The content of the virtual image is edited. Finally, the virtual image is written to the 
multi- session CD-R disc.

1. Select the    Append    option from the    Session    menu. 

2. Select a session/track number; this track will be used as the basis of the virtual image (the
default number is that of    the last session on the disc). If the selected session/trackis an audio
track select the data format of the next session (ISO or XA) and enter the name of the new
session. If the selected session/track is a data track this information need not be entered, as it
is derived from the session on the CD-R. The selected session/track on the CD-R disc is read
and the virtual image created. The virtual image contains the same directory/file structure as that
of the session. The data structure is displayed in the GEAR Status window. 

Important
The virtual image is automatically assigned the same name as the selected session. If a virtual
image with this name (i.e. the original virtual image) is    present, GEAR warns you and asks if it
should overwrite. If you don't want to overwrite the existing virtual image, use another directory for
saving the new virtual image to.

Note
This procedure does not delete or corrupt data on your CD-R disc.

3. Add or remove files just like with any other virtual image; select and drag them from the File
Manager window. Files belonging to the original session are colored differently to those added to
the virtual image.

The directory tree is always recreated,    allowing you to remove information from a session
Therefore, directory names are the same color as newly added files names.

The new session can be appended to the CD-R by using the    Write    menu. Only the changes 
will

be written to the CD-R disc! Remember: every session on a CD-R disc contains approximately
15 Mb of overhead.



Editing Volume Settings
This option allows you to edit the volume settings for the currently selected volume. The default values 
are specified in the GEAR.INI file and can be changed with the Generator options of the Settings menu. 
The content of the GEAR.INI file and the default values are explained in chapter 11.

1. Select the Volume Settings... option from the Edit menu. The volume settings window is 
displayed.    
2. Change the settings according to your needs.

Note
- The maximum number of directories cannot be changed for the currently selected volume.
- This only affects the currently selected volume.



Running a Batch File
Starts executing commands from the given batch file.

A batch file can either be a log file from a (previous) GEAR session or a man ually created batch file. The 
commands in the batch file are read on a line by line basis. Any line that starts with a semi-colon will be 
treated as a remark and will be skipped when the batch is run. Lines starting with an unknown command 
will also be skipped. If parameters are missing or invalid, the software will ask you to insert them again. 

1. Selecting the    Run Batch...    option from the    Session    menu.

2. The    Name of batchfile    window opens. Select a batch file to be run. To change the current
directory select the relevant directory string from the    Directories    tree.

3. Click on OK to confirm the batch file name; the batch file starts to run. Lines starting with an
unknown command will also be skipped. If parame ters are missing or invalid, the software will
ask you to insert them again. 

A batch file can be created/edited with any text editor. Refer to your text editor manual for further 
information. Any GEAR for DOS command can be used in the batch file. Refer to Appendix F for a 
complete list and description of these com mands.



Running a Command
This option can be used to execute a single batch command.

1. Selecting the    Run Command...    option from the    Session    menu. The window allows you to 
enter

one command with its parameters.

2. Click on OK to confirm the command line.

Any GEAR for DOS command can be used. Refer to Appendix F for a complete list and description of 
these commands.



Verify
During verification the time, date and size of each file in the track/volume (at the time of loading) is 
compared with the current time, date and size. If a file is not up to date, GEAR displays a message. The 
track/volume can be updated by reloading the reported files.

1. Open the volume you want to verify (refer to Section 5.1)

2. Click on    Verify    in the    Image menu. 

3. The next window asks if you want to verify the currently selected track or volume. Click on    Track
or    Volume . Verification starts. A    status report is displayed in the GEAR Status window.



Physical Volumes
A physical volume is a byte for byte copy of the future CD-ROM.    It is not strictly necessary to write a 
physical volume, a virtual volume can always be used. But, if the data transfer rate for CD-Recording 
needs to be increased a physical volume should be used.

Before writing the physical volume, GEAR verifies the virtual volume. If any file is not up to date the 
physical volume will not be written. The virtual volume can be updated by reloading the reported files. 

For each track in the virtual volume a physical volume file is created. The sector size for the ISO track (if 
present) will be 2048 bytes. The sector size for the CD-ROM XA track (if present) will be 2336 bytes while
the sector size for the DA track (if present) will be 2352 bytes. 

The physical volume contains the contents of the virtual volume at the time of creation. Any subsequent 
changes to the virtual volume do not affect the current physical volume!

The physical volume file names are <volume name>.Pxx where xx stands for the track number. These 
files are always written to the GEAR working directory.

1. Open the virtual volume you want to create a physical volume for (refer to Section 5.1)

2. Click on    Convert to Physical    in the    Image menu. 

3. The next window asks if you want to create physical image files for the currently selected track
or volume. Click on    Track    or    Volume . Verification starts. A    status report is displayed in the
GEAR Status window.

4. If verification is successful creation of the physical volume/track will start. If physical files already
exist for the volume/track you will be asked if you want to overwrite them.



Estimate
This option checks the performance of your system for writing the selected volume to CD-R disc. The 
software measures the time it needs to read all the information from the selected volume and transfer it to
the CD-Recorder with the current speed settings. No data is transferred to the recorder. During the 
estimate the software displays which parts of the image cannot be read fast enough (if any).

Please read the next section for ways to improve the system performance in case this happens. 

Note: An estimate only measures the time it needs to read all the information from the selected volume. 
The SCSI controller used for the CD-Recorder and the internal buffer of the CD-Recorder is not taken into
account. You can use Writing to CD-R with the Write Enable option off to do a complete performance test 
of your system.

Note
Due to the nature of an estimate, the Estimate command cannot guarantee that the disc will be 
successfully written!

1. Open the virtual volume you want to do an estimate for (refer to section 5.1)

2. Click on    Estimate    in the    Write    menu. If the physical volume is not available you will be 
asked

if the virtual volume should be used. During    estimate a status report is displayed in the GEAR
Status window.



Writing to CD-R
When writing a CD Image (volume) to a CD-R disc, GEAR can use either the virtual volume or the 
physical volume file(s). When the virtual volume is used, the physical volume is constructed and 
immediately written to disc. Writing from a physical volume is, in principle, faster than writing from a virtual
volume.

If the    EstimateBeforeWrite    option is enabled GEAR will check the performance of your system first 
before writing the selected volume to CD-R disc. If the performance is sufficient, the software will continue
with writing the disc, otherwise the writing will be aborted.

Important
The system has to maintain a high data transfer rate to the CD-Recorder. If this transfer rate can not be 
maintained, the writing of the CD-R disc will fail. CD-R discs can be written at single speed, double speed 
or quadruple speed. The data transfer rate is dependent on the speed of recording and the type of track 
(ISO, CD-ROM XA, CD Digital Audio) written (see table).

    1x     2x     4x     6x
ISO 153 Kb/s 307 Kb/s 614 Kb/s 918Kb/s
CD-ROM XA 175 Kb/s 350 Kb/s 700 Kb/s 1050Kb/s
CD Digital Audio 176 Kb/s 352 Kb/s 705 Kb/s 1056Kb/s

For external volumes the required transfer rate depends on the selected sector size. 2048 bytes per 
sector is comparable to ISO, 2336 bytes per sector CD-ROM XA and 2352 bytes per sector CD Digital 
Audio.

If the CD-Recorder supports a test mode or write disable mode (like most CD-Recorders do), the    
WriteEnable    option of the    CD-R Settings window (refer to the    Options    menu) can be used to check if
the image can be written to CD-R disc.    If the    WriteEnable    option is disabled, all information is 
transferred to the CD-Recorder but the disc is not actually written. Therefore, the performance can be 
checked without wasting a disc. In case the performance of your system is not sufficient you can try the 
following:

- Use a lower recording speed if possible.
- Use a physical volume instead of a virtual image.
- Minimize disk fragmentation.
- Check if you are running applications in the background and if so disable them during writing of

the CD- R disc.
- Check if your hard disk does recalibration.
- Check if Windows has enough free memory; if Windows has not enough memory it will use hard

disk space as memory. This will slow down the performance considerably.
- Check your smartdrive configuration. If you are using a physical volume disable smartdrive for the

drive on which the volume files are located. If you are using a virtual volume enable smartdrive for
the drive where the volume files are located.

- Check if the SCSI termination is correct. Wrong SCSI termination could cause delays on the
SCSI bus.

Important
The performance of the system for writing a CD-R disc is better if the access time of your hard disk is 
lower. This is more important than a faster processor. A lot of hard disks currently on the market regularly 
perform what is called ‘recalibration . Recalibration means that the hard disk verifies its read/write 
operation to prevent problems. If this happens during the writing of a CD-R disc, this might result in a data
transfer problem. Refer to your hard disk documentation or speak with your supplier to check whether or 
not your hard disk performs recalibration.



Information
The best hard disks for writing CD-R discs are the so called ‘multi media    or ‘AV    hard disks. This type of
hard disk minimizes the recalibration time and guarantees a high sustained data rate.

The CD-R option always creates the following files after an image has been written: WO_IDENT.TXT and 
WORESULT.TXT. The WO_IDENT.TXT file contains the TOC (Table of Contents) plus some customer 
information of the image written to CD- Recorder. The customer information is read from the GEAR.INI 
file. The WORESULT.TXT file contains status information.

1. Open the virtual volume you want to write to CD-R (refer to section 5.1)

2. Click on    CD-R    in the    Write    menu. If the physical volume does not exist, you are then asked 
if

the virtual volume should be used for writing to CD-R; if you select    No , writing is aborted.
During    CD-R writing a status report is displayed in the GEAR Status window.



Writing to a Premaster Tape
Use this option to write a volume to (premaster) tape. The tape is written in ANSI (X3.27-1987) format. 
GEAR can use either the virtual volume or the physical volume file(s).    When the virtual volume is 
selected, the physical volume is constructed and immediately written to tape. 

The premaster tape can be sent to a replication company for mastering and replication. If    
VerifyAfterWrite    is enabled GEAR verifies the contents of the tape with the volume after writing to 
premaster tape.

The software supports most tape units providing that they use a SCSI interface (e.g. EXABYTE, DAT, M4 
9track). The preferred configuration is the Adaptec 1540 or 1542 interface card with an EXABYTE tape 
unit, a Hewlett Packard DAT unit (HP35470A) or an M4 9track unit.

The following files are created after an image has been written to tape: TP_IDENT.TXT, TPRESULT.TXT, 
DDPID, DDPMS and PQDESCR. The TP_IDENT.TXT file contains the TOC (Table of Contents) of the 
image written to tape plus some customer information. The DDPID, DDPMS and PQDESCR files together
form the DDP information of the last image written to tape. These files can be written to tape:

Writing DDP Files to Premaster Tape.
1. Click on the    Settings    option in the    Options    menu.

2. Click on    Tape... . The    Tape Setup    window opens.

3. To enable writing of the DDP information to the tape click on the    Write DDP files to tape
option.

The customer information is read from the GEAR.INI file (refer to Chapter 10). The TP_IDENT.TXT file 
contains status information. It can be sent along with the premaster tape to the mastering company or can
be written to tape:

Writing the TP_IDENT.TXT File to Premaster Tape.
1. Click on the    Settings    option in the    Options    menu.

2. Click on    Tape... . The    Tape Setup    window opens.

3. To enable writing of the TP_IDENT.TXT file to the tape click on the    Write TP_IDENT.TXT file to
tape    option.

Writing to Premaster Tape
1. Open the virtual volume you want to write to premaster tape (refer to section 5.1)

2. Click on    Premaster Tape    in the    Write    menu. You are then instructed how to set up the tape
unit for recording. When the unit is ready click on    OK    to confirm writing. During    writing a
status report is displayed in the GEAR Status window.



Disc Information
This option displays information about the CD-R disc in the CD-Recorder. The following information is 
available:

- Type of CD-R disc.
- Number of sessions on the CD-R disc.
- Number of tracks on the CD-R disc.
- Start time (ATIME) of each session and track.
- The type and size of each track.
- Start time of the 'lead out'.

Notes
- The information displayed depends on the type of CD-Recorder. Not all CD-Recorders can give

all the information mentioned above.
- An ATIME is specified as mm:ss:ff where mm specifies the number of minutes, ss the number

of seconds and ff the number of sectors.
- The lead out is specified as the latest possible start position for the lead out and thus also

indicates the CD-R capacity. For mastered CDs the start of the lead out indicates the end of
the data area on the disc. If    multi session disc is loaded the CD-Recorder will report that the
last session on the disc is unfinished. This is because a recorder will always create the
beginning of a new session when closing the last session on the disc.

1. To display the disc information select the    DiscInfo    option from the    Options    menu.



Read Track
This option can be used to read back a complete track from a CD-R disc and create a byte for byte copy 
of an existing track on the CD-R.

Notes
- Not all recorders support the reading of audio tracks via the SCSI bus. At the time of going to

print only the Yamaha CDR-100 and the Philips CDD522 support this.
- When reading audio with the CDD522 make sure that your computer is fast enough to store

the audio data. If this is not the case, the CDD522 will skip parts of the audio.

1. Select the Readtrack option from the Tools menu. The Readtrack window allows you to select
a track from the CD-R and enter a file name.

2. Click on OK to confirm. The reading starts. A status report is displayed in the GEAR Status
window.



Jukebox Control
This option can be used to control a Jukebox supported by GEAR.

Notes
- Currently GEAR supports the ASM Jukebox, the Pioneer Jukebox and the Kodak Disc

Transporter.
- If you want to use a Jukebox to write several CD-Rs unattended, make sure that they are loaded

consecutively from slot 1
- You can also use the GEAR batch command `MOVEMEDIUM' to control the place of CD-R

media in the Jukebox.

1. Select the Jukebox control... option from the Tools menu. The Jukebox control window allows
you to move CD-R media around in the Jukebox.

Click on the different controlls to see their function...

    

      



GEAR On-Screen Windows
Status
This option determines if the GEAR Status window is opened or closed. The GEAR Status window 
displays information related to the virtual image:

- image size
- number of tracks
- remaining free space
- the name of the file being loaded into the image.
- log content

1. By default the GEAR Status is shown. To close select the    Status Bar    option from the    Options
menu. To open simply repeat this procedure.



CD-ROM XA
The option is used to specify Multi Media Files (MMF) on a CD-ROM XA track. A volume and CD-ROM 
XA track must first be selected.

Manual Interleave
When Manual Interleave is enabled the you must specify for each copying action the following 
information.

Data type
Specifies the type of each file that is loaded. Valid types are ADPCMBSN, ADPCMBSE, ADPCMBMN, 
ADPCMBME, ADPCMCSN, ADPCMCSE, ADPCMCMN, ADPCMCME, VIDEO2048, VIDEO2324 and 
DATA2048. 

ADPCMBSN is valid for ADPCM Audio, level B Stereo, No emphasis.
ADPCMCME is valid for level C Mono with emphasis. 
VIDEO2048 is used if each sector contains VIDEO data and ECC/EDC codes.
VIDEO2324 is used if each sector contains VIDEO data.

Channel number
Specifies the channel number for each file that is loaded. This number can range from 0 to 31.

Interleave data factor
Specifies the interleave factor for each file that is loaded. Refer to interleave total factor for an 
explanation. This number can range from 1 to 16.

Interleave total factor
Specifies the total interleave factor of each file that is loaded. This number, together with the interleave 
data factor determines the interleaving of each file. Valid combinations for interleave data factor and 
interleave total factor are: 1 - 4, 1 - 16, 1 - 8, 2 - 4 etc. The combination 2 - 4 means that for each set of 4 
sectors the first 2 are occupied by the file. The interleave total factor can range from 1 to 16. ADPCM B 
Stereo files are interleaved 1 to 4 while ADPCM C Stereo files are interleaved 1 to 8.

Bit set
EOR specifies if the End Of Record (EOR) bit should be set in the sub-header of the last sector of each 
file that is loaded. This parameter can be specified together with the Trigger parameter.

Trigger specifies if the Trigger bit should be set in the sub-header of the last sector of each file that is 
loaded. This parameter can be specified together with the EOR par ameter.

To enable Manual Interleave:
1. Select the    XA    option from the    Options    menu.
2. Select    the    Manual Interleave    option.

This option allows you to specify all the options to create your own interleaved files. More information 
about the use of these parameters for CD-ROM XA applications can be obtained from the CD-ROM XA 
specification [4]. 

Note
In general it is easier to use the dedicated CD_ROM XA interleaving tools (like the Mammoth Tool Set) 
and the GEAR pre-interleaved option for creating these files .

Pre-interleaved
If the    Pre-interleaved    option is switched on, it is assumed that the specified files are pre-interleaved 
CD-ROM XA files (sometimes referred to as    XA streams). GEAR can not check if a file is pre-interleaved



or not, and therefore you can load any file as a pre-interleaved file.

Important
Make sure that the files you are loading with this option are indeed pre-inter leaved files. Non pre-
interleaved files loaded with this option as pre-interleaved files are useless on the resulting CD-R disc! A 
pre-interleaved file must have a 2336 bytes sector size with the sub-header field filled in. This sub-header 
field is then copied together with the other information to the GEAR administration file. Normally the sub-
header field is NOT included in a file and the sub-header information is generated by GEAR.

To enable Pre-interleave:
1. Select the    XA    option from the    Options    menu.
2. Select    the    Pre interleaved    option.



Generator Setup
The following formatting settings are saved in the GEAR.INI file (refer to section 11.2 for further 
explanation of these formatting settings):

- System Identifier
- Publisher Identifier
- Data Preparer Identifier
- Application Identifier
- Application Use
- Copyright File Identifier
- Abstract File Identifier
- Bibliographic File Identifier
- Maximum Directories in Volume
- Directory Nesting level
- Archive Files only 
- Non ISO names handling

1. Select the    Settings    option from the    Options    menu.
2. Select    the    Generation...    option.

Some of these settings can also be set with the    Volume Descriptor...or    Volume Settings...    option of 
the    Edit    menu. However, the difference is that the settings in the GEAR.INI file are used as the default 
for each new volume, while the items which are edited with the    Volume Descriptor...    option are only 
valid for the currently selected volume.

The following settings are not saved in the GEAR.INI file. Nonetheless, they do remain valid as long as 
the GEAR software is running.

Hidden
Changes the hidden mode. The hidden mode specifies if the files and directories, when loaded,
are hidden or not. Files and directories are hidden if the hidden mode is on. Otherwise they will
be loaded normally. Hidden files and directories, even during simulation, do not appear in the
directory listing. Default value for this mode is off.

StartSector
Changes the sector mode. The sector mode specifies if the start sector of a file can be specified
or not. The start sector of a file can be specified if the sector mode is on.    Default value for this
mode is off.



CD-R Setup
Defines the setup settings which are used when writing the CD-R disc and/or    estimating the 
performance. The user can specify the following information:

1. Select the    Settings    option from the    Options    menu.
2. Select the    CD-R...    option.

These settings are saved in the GEAR.INI file and become the default settings. 



Premaster Tape Setup
Defines the setup settings which are used while writing the premaster tape and/or while verifying the tape.
The user can specify the following information:

1. Select the    Settings    option from the    Options    menu.
2. Select    the    Tape...    option.

The user can also select which method will be used when writing to tape:

Tracks on separate tapes
Each track is written to a separate tape file on a separate tape. It is not possible to write DDP information 
to tape when using this method.

Tracks in separate files
Each track is written to a separate tape file. All files are then written to one tape. This method is the 
default.

Same type of tracks in one file
Tracks of the same type are combined into one tape file. The tape files are then written to the same tape. 
This option may be useful when there are many small audio tracks present in the volume. Using the 
previous methods would result in a large number of filemarks on the tape that could give problems while 
mastering. The use of the DDP option is advised when this method is used.

One contiguous image file
All tracks are written to one file (contiguous image). Sector size, scrambling, blocking factor and 
gap/pause inclusion are set to the following mandatory values:

Sectorsize=2352
Scrambled=TRUE
Blocking factor=6
Gaps/pauses=Included



Important
The use of the DDP option is advised when using this method.

The GEAR software can generate tape images which include ECC and EDC codes. These correction and
detection codes are only generated for data tracks if a sector size of 2336 or 2352 bytes has been 
selected. 

Not all combinations of the above options are possible. The Tape command prevents the user from 
choosing combinations that are invalid. In general it is sufficient to use the default settings as specified in 
the supplied GEAR.INI file (refer to Appendix B). If you change the settings this information will be saved 
in the GEAR.INI file: these become the default settings.



Customer Settings
Shows the customer information that is used. This information is stored in the GEAR.INI file. The 
information can be changed in the    Customer setup    window or by editing the GEAR.INI file directly.

1. Select the    Settings    option from the    Options    menu.
2. Select    the    Customer...    option.

These settings are saved in the GEAR.INI file and become the default settings. 



Setting the Working Directory
Defines the GEAR working directory. This directory will be used as the default working directory when 
opening and creating a volume.

1. Select the    Settings    option from the    Options    menu.
2. Select    the    Working Directory...    option.



What is the GEAR.INI file?
The GEAR.INI file contains configuration information and information messages used by GEAR. The 
GEAR.INI file can be edited with any text editor.

During startup GEAR tries to locate the GEAR.INI file in the current working directory. If this file is not 
present in the current working directory, the GEARDIR environment variable (refer to section 3.2, software
installation) will be used to locate it. Be sure that the software can locate the GEAR.INI file since without 
the information in this file GEAR cannot run properly. GEAR will notify you if it cannot locate the GEAR.INI
file.

The GEAR.INI file can be edited with a standard text editor to change the configuration information. 
However, it is preferable that this information is changed via the GEAR menus.
- Lines starting with a semi-colon are treated as comments.
- Parameters must be entered immediately after the '=' sign; the parameters are interpreted starting

with the first character after the equal sign.
- All parameters are case sensitive.

The use of each entry in the GEAR.INI is as follows (refer to Appendix B for the complete list of entries in 
the GEAR.INI file). 



Generic Information
Geometry Fields
These store the geometry information of the three main windows which are displayed while running 
GEAR. At startup GEAR uses this information to position and size these windows on the screen. Do not 
change these values yourself!

GearGeometry = 0,0,385,350
StatGeometry = 0,350,640,480
FileGeometry = 231,71,640,350

Identification fields
This information from the GEAR.INI file is written to the TP_IDENT.TXT and the WO_IDENT.TXT files 
when writing to a premaster tape or CD-R disc. Some premaster companies ask you to supply this 
information on premaster tape and/or on paper.

CustomerName=Your own Name
CustomerContact=Your contact person
CustomerPhone=Your telephone number
MasterIDCode=Your mastering code
ReferenceCode=Your reference code
DiscTitle=Your new CD title

The first three fields can be the same for all your CD-ROM titles. The last three fields are usually different 
for each CD-ROM title.

WorkingDirectory
This field specifies in which directory the GEAR software looks for the volume administration files during 
startup. If this field is not specified the software uses the directory specified as the working directory in the
program properties window.



Generation Information
The following information is used during the creation of a volume. Afterwards this information can be 
changed for the selected volume using the    Volume Descriptor...    option of the    Edit    menu. All 
identifiers must conform to the ISO standard for interchange level 1 (refer to Appendix A). GEAR uses the
default values if the fields are not specified.

SystemIdf
This field specifies the identification of the system.
Default value is the empty string.

PublisherIdf
This field specifies the identification of the person(s) who specified the content of the volume set of which 
this volume is a member. If the first character is a '_' , the rest of the field will specify an identifier for a file 
containing the publisher identification. This file has to be loaded in the root directory.
Default value is the empty string.

Note
When a filename is specified (by means of '_' as first character) an extension and/or version number may 
be omitted.

DataPreparerIdf
This field specifies the identification of the person or other entity which controls the preparation of the data
to be recorded on the volume. If the first character is a '_'    the rest of the field shall specify an identifier 
for a file containing the data preparer identification. This file has to be loaded in the root directory.
Default value is the empty string.

ApplicationIdf
This field specifies the identification of the specification of how the data is recorded on the volume set of 
which this volume is a member. If the first character is a '_' , the rest of the field shall specify an identifier 
for a file containing the application identification. This file has to be loaded in the root directory.
Default value is the empty string.

ApplicationUse
This field specifies the language identification for an EB (XA) disc (for further information refer to 
document [6]).
Default value is the empty string.

CopyRightFileIdf
This field specifies the identification for a file loaded in the root directory and containing a copyright 
statement for the volume set.
Default value is the empty string.

AbstractFileIdf
This field specifies the identification for a file loaded in the root directory and containing an abstract 
statement for the volume set.
Default value is the empty string.



BibliographicFileIdf
This field specifies the identification for a file loaded in the root directory and containing bibliographic 
records interpreted according to standards that are the subject of an agreement between the originator 
and the recipient of the volume.
Default value is the empty string.

MaxDirNestingLevel
This field specifies the maximum directory nesting level for the CD (the root is level 1). ISO allows a 
directory nesting level upto 8 while GEAR allows a directory nesting level upto 12.
Default value is 8.

MaxNrDirsInVolume
This field specifies the maximum number of directories in the volume in order to calculate the number of 
blocks needed for the path tables. This maximum number may not be larger than 65535.
Default value is 500.

ArchivesOnly
DOS uses the Archive information to determine if a file has to be 'backed up' or not. Tape archiving 
software usually only archives files which have the archive bit set. This information is reset when the file is
written to tape. GEAR offers you the same functionality for CD-R writing. When the ArchivesOnly option is
set GEAR only loads files with the Archive bit set into the image. The archive bit will be reset when the file
is successfully loaded into the GEAR image. Valid values are TRUE and FALSE.
Default value is FALSE. 

NonIsoNameHandling
This field specifies how non ISO names for files and directories are handled. Valid values are:
0 A dialog box appears for each non ISO name encountered. This dialog box will give you the

possibilities to skip the file or translate the file name to an ISO compliant name.
1 All non ISO names will be ignored and each file will be loaded with it's original name.
2 All lower case characters will be translated to upper case characters. If the name still contains

non ISO characters after that, the same dialog box as for option 0 will appear. This option is
especially useful in the UNIX environment.

3 All non ISO names will be translated to ISO compliant names. Non ISO characters will be
replaced by an underscore. If duplicate file names are generated a warning will appear.

4 All names will be translated so that they comply to ISO level 1.
5 All names will be translated to ISO level 1 AND the Rock Ridge specific information is added to

the 'system use' field of each file and directory. The Rock Ridge information is specified in the
(proposed) IEEE standards P1281 and P1282; it is specifically meant for UNIX systems and
thereforeoption 5 should only be used on UNIX systems.

Default value is 0.



CD-R Information
The following fields can also be changed using the    CD-R...    option from    the    Settings    submenu of 
the    Options    menu (refer also to section 10.2, CD-R Setup). All fields must be specified! The values as 
specified in the supplied GEAR.INI file are usually used.

UsePhysicalImageFiles
This field specifies if the physical image is used for writing to the CD-Recordable. Sometimes it might be 
necessary to use a physical image file to meet the data transfer rate requirements; in general writing 
using the physical image is faster. Valid values are TRUE and FALSE.
Default value is FALSE.

MultiSession
This field specifies if the CD-R disc is recorded in such a way that new sessions (data) can be appended 
to the disc in future. If a CD-R disc is written with this field set to FALSE the disc can never be used for 
recording new sessions. If the CD-Recorder does not support this mode the field will be ignored. Valid 
values are TRUE and FALSE.
Default value is TRUE.

WriteEnable
This field specifies if the CD-Recorder actually writes the image file to the CD-Recordable. Some CD- 
Recorders can be set to a so called test mode in which case the data is not actually written to CD-R disc. 
This mode can be used to test if the computer system can meet the data transfer requirements of the CD-
Recorder for a specific CD-ROM image file. If the CD-Recorder does not support this mode the field will 
be ignored. Valid values are TRUE and FALSE.
Default value is TRUE.

Note
Some recorders do not have the possibility to set this mode using the software but instead use a switch 
on the unit (SONY).

Speed
This field specifies the recording speed of the CD-Recorder. A value of 1 means real-time recording (150 
Kb/s). If the recorder does not support this option this field is ignored. Valid values are 1, 2, 4 and 6.
Default value is 2.

Fixation
This field specifies if the CD-Recorder will fixate the CD-ROM after the image file has been written to the 
CD-Recordable. If the CD-Recorder does not support this mode the field will be ignored. This option can 
be used to write 'track at once'; the last track must be written with fixation set to TRUE and all the 
previous tracks must be written with fixation set to FALSE. Valid values are TRUE and FALSE.
Default value is TRUE.

Warning
If an image is not fixated it cannot be read on a CD-ROM player!

LinearVelocityLevel



This field specifies the linear velocity level used by the CD-Recorder for writing the image file to the CD-
Recordable. This field is only valid for the Yamaha PDS 301. The lower the linear velocity level the more 
data can be written to the CD-Recordable (refer also to the Yamaha PDS 301 documentation). Valid 
values are 1, 2 or 3.
Default value is 2.

NrOfWriters
This field specifies the number of writers used by the CD-Recorder while writing the image file to the CD-
Recordable. This field is only valid for the Yamaha PDS 301 and the Sony CDW900E. Valid values are 1 
to 14 for the Yamaha and 1 to 32 for the Sony. 
Default value is 1.

Note
If multiple writers are used for the Yamaha the writers must have successive numbers (refer also to the 
Yamaha documentation)!

EstimateBeforeWrite
This field specifies if GEAR does a performance check before it writes the data to CD-Recordable. Valid 
values are TRUE and FALSE.
Default value is FALSE.

IncrementalWrite
This field specifies whether GEAR uses incremental write while writing the data source to CD- 
Recordable. Not all CD-Recorders support incremental write, in that case this field will be ignored. 
Currently only the RICOH RS 9200 supports incremental write. Valid values are TRUE and FALSE.
Default value is FALSE.

CDRInterface
This field specifies the CD-R interface to be used. Supported are:

0) Null device
1) Adaptec AHA-1540/AHA-1542 board driver (SCSI)
2) ASPI for DOS driver (e.g. ASPI4DOS.SYS)
3) ASPI for Windows driven (WINASPI.DLL)
4) Future Domain CAM driver

Default value is 2.

AdaptecIOAddress
This field specifies the IO address at which GEAR searches for the Adaptec card. If you change this 
address don't forget to change the settings on the card accordingly! Refer to the Adaptec installation 
guide for valid addresses and how to change the address on the card. This field must be specified if you 
have chosen    the Elektroson driver (CDRInterface type 1)! If you are using the ASPI interface or CAM 
(CDRInterface type 2,3 and 4) this field is ignored. Refer to section 3.3 for the other settings on the 
Adaptec board.
Default value is 230h.

AspiHostAdapterNumber
Selection of the ASPI host adapter number which is used. This field is only used when CDRInterface 2 is 
selected. Valid values are 0, 1 and 2. If you are using the ASPI manager as the device interface for 



multiple controllers and your CD-Recorder is recognized by ASPI but not by the GEAR software, you 
probably have to change the AspiHostAdapterNumber.
Default value is 0.

CDRTargetID
This ID can range from 0 to 6; ID 7 is normally used by the Adaptec controller. If only one CD-R unit is 
connected the software will automatically find the unit regardless of its ID. If multiple units are used, the 
unit with the specified CDRTargetID is used. If no unit is found at CDRTargetID the unit with the highest ID
is used.
Default value is 4.

UseMediumChanger
This field specifies whether the GEAR software will look for a medium changer for loading and unloading 
CD-R discs. Currently the GEAR software supports the ASM Jukebox, the Pioneer Jukebox and the 
Kodak Disc Transporter. Valid values are TRUE and FALSE.
Default value is TRUE.

BufferSize
This field specifies the BufferSize in bytes allocated by GEAR for writing the CD-R disc. The number of 
bytes must be between 1 and 65000. A larger buffersize might be useful when the data transfer rate has 
some unexpected 'dips'. If the average transfer rate is too low a large buffersize does not always help.
Default value is 64000.

NrOfBuffers
This field specifies whether or not GEAR should use two buffers concurrently for writing the CD-R disc 
(sometimes referred to as QuickDMA). When using one controller for both CD-Recorder and hard disk 
drive, it might be necessary to set NrOfBuffers to 0. Valid values are 0 for 1 buffer and 1 for 2 buffers in 
parallel.
Default value is 1.

DriveNrInMediumChanger
This field specifies which drive in the Jukebox is the CD-Recorder. Currently there is no other way for 
GEAR to get this information. Valid values depend on the number of the driver in the Jukebox.
Default value is 1 (first drive in the Jukebox).

VerifyImage
This field specifies if the GEAR image should be verified before it is converted to a physical image, written
to CD-R or written to premaster tape. A verify will, for each file in each track in the virtual image, check the
time, date and size at loading against the current time, date and size of the file. If any file is not up to date 
a message will be displayed. 



Premaster Tape Information
The following fields can also be changed using the    Tape...    option from    the    Settings    submenu of the
Options    menu (refer also to section 10.3, Premaster Tape Setup). The fields which specify CD-ROM XA 
related information are ignored in the ISO only version.    All fields must be specified! The values as 
specified in the supplied GEAR.INI file are usually used.

DDPFormatTape
This field specifies if the DDP files (DDPID, DDPMS and PQDESCR) are written to the premaster tape. 
The DDP files are also written to hard disk. Valid values are TRUE and FALSE.
Default value is FALSE.

FileOption
1) Tracks on separate tapes: each track is written to a separate tape file on a separate tape. It is

not possible to write DDP information to tape when using this method.
2) Tracks in separate files: each track is written to a separate tape file. All files are then written to

one tape. This method is the default.
3) Same type tracks in one file: tracks of the same type are combined into one tape file. The tape

files are then written to the same tape. This option is useful when there are many small audio
tracks present in the volume. Using the previous methods would result in a large number of
filemarks on the tape that could give problems while mastering.
The use of the DDP option is advised when this method is used.

4) One contiguous image file: all tracks are written to one file (contiguous image). Sector size,
scrambling, blocking factor and gap/pause inclusion are set to mandatory values.

Default value is 2.

ISOTrackBlockingFactor
This field specifies the tape blocking factor for an ISO track. Valid values are 4 and 6.
Default value is 4.

ISOTrackSectorSize
This field specifies the sector size to be used on tape for an ISO track. Valid values are 2048 and 2352 
(ECC/EDC will be added for sector size 2352).
Default value is 2048.

ISOTrackWithPregapPostgap
This field specifies if the pregap and postgap are written to tape for an ISO track. Valid values are TRUE 
and FALSE.
Default value is FALSE.

XATrackBlockingFactor
This field specifies the tape blocking factor for a CD-ROM XA track. Valid values are 4 and 6. 
Default value is 6.

XATrackSectorSize
This field specifies the sector size to be used on premaster tape for a CD-ROM XA track. Valid values are 



2336 and 2352 (ECC/EDC will be added for sector size 2352).
Default value is 2336.

XATrackWithPregapPostgap
This field specifies if the pregap and postgap are written to premaster tape for a CD-ROM XA track. Valid 
values are TRUE and FALSE.
Default value is FALSE.

DATrackWithPause
This field specifies if the pause of CD Digital Audio tracks is written to premaster tape. Valid values are 
TRUE and FALSE.
Default value is FALSE.

ScramblingFor2352Sectors
This field specifies if the 2352 sectors must be scrambled before they are written to premaster tape. This 
field is only used if the sector size of the track written to tape is 2352. Valid values are TRUE and FALSE.
Default value is FALSE.

WriteIdentTxtOnTape
This field specifies if the TP_IDENT.TXT file is written to tape. Valid values are TRUE and FALSE.
Default value is FALSE.

UsePhysicalImageFiles
This field specifies if a physical image file is used for writing to the premaster tape unit. In general writing 
using the physical image is faster. Valid values are TRUE and FALSE.
Default value is FALSE.

VerifyAfterWrite
This field specifies whether GEAR does verification after it has written the data source to premaster tape. 
Valid values are TRUE and FALSE.
Default value is FALSE.

TapeInterface
This field specifies the tape interface to be used. Supported are:

0) Null device
1) Adaptec AHA-1540/AHA-1542 board driver (SCSI)
2) ASPI for DOS driver (ASPI4DOS.SYS)
3) ASPI for Windows (WINASPI.DLL)
4) Future Domain CAM driver

Default value is 2.

AdaptecIOAddress
This field specifies the IO address at which GEAR searches for the Adaptec card. If you change this 
address don't forget to change the settings on the card accordingly! Refer to the Adaptec installation 
guide for valid addresses and how to change the address on the card. This field must be specified if you 
have chosen    the Elektroson driver (TapeInterface type 1)! If you are using the ASPI interface 



(TapeInterface type 2) this field is ignored. Refer to section 3.3 for the other settings on the Adaptec 
board.
Default value is 230h.

AspiHostAdapterNumber
Selection of the ASPI host adapter number which is used. This field is only used when TapeInterface 2 is 
selected. Valid values are 0, 1 and 2. If you are using the ASPI manager as the device interface for 
multiple controllers and your Tape unit is recognized by ASPI but not by the GEAR software, you probably
have to change the AspiHostAdapterNumber.
Default value is 0.

TapeTargetID
This ID can range from 0 to 6; ID 7 is normally used by the Adaptec controller. If only one tape unit is 
connected the software will automatically find the unit regardless of its ID. If multiple units are used, the 
unit with the specified TapeTargetID is used. If no unit is found at TapeTargetID the unit with the highest ID
is used.
Default value is 4.



ISO-9660 File and Directory Naming
File name
Each file name consists of three components: name, extension and version number as follows:
<name>.<extension>;<version>

A name or extension consists of zero or more characters of the set [A..Z], [0..9] and _ (underscore). The 
version number ranges from 1 to 32767. The name and extension together must consist of at least one 
character e.g. .000;1 is a valid ISO-9660 file name

There are three levels of interchange defined by ISO-9660:

-Level 1
The number of characters of the name is restricted to 8 and the number of characters of the extension is 
restricted to 3.
-Levels 2 and 3
The total length of the name and extension is restricted to 30 characters (excluding the point and semi- 
colon). Within GEAR the file name length is restricted to 30.

Order of files in a directory
Files are listed in alphabetical order. If two file names do not have the same number of characters the 
shorter name is treated as if extended with spaces. This rule applies for both the name and the extension.
If two files have equal names the file with the highest version numbers comes first e.g. AA.;2 before AA.;1.

Directory names
A directory name consists of one or more characters of the set [A..Z], [0..9] and _ (underscore) with a 
maximum of 31 characters. The maximum nesting level of directories is 8 (the root is level 1!). The total 
number of characters specifying a file within a directory (path) must be smaller than 256. Directories are 
sorted alphabetically.

Sorting order
The order of characters is according to ISO 646, i.e. [0..9] comes before [A..Z] and [A..Z] comes before _ 
(underscore).



GEAR.INI
The default contents of the GEAR.INI file are as follows.

; GEAR specific INI file
;
;
[generic]
;
; Customer information
;
CustomerName=
CustomerContact=
CustomerPhone=
MasterIDCode=
ReferenceCode=
DiscTitle=
;
WorkingDirectory=
;
[generator]
;
SystemIdf=GEAR FOR WINDOWS VERSION 3.2 JANUARY 1995
PublisherIdf=
DataPreparerIdf=ELEKTROSON BV 1995
ApplicationIdf=
ApplicationUse=
CopyRightFileIdf=
AbstractFileIdf=
BibliographicFileIdf=
ArchivesOnly=FALSE
MaxDirNestingLevel=8
MaxNrDirsInVolume=500
; Selection of ISO names handling
;    0. A dialog appears for each non ISO name
;    1. Ignore all non ISO names
;    2. Translate to Upper case only
;    3. Translate to ISO complete
NonIsoNameHandling=0
;
;
;
[tape]
;
UsePhysicalImageFiles=FALSE
DDPFormatTape=FALSE
;Selection of tape writing method
; 1. Tracks on separate tapes:
; 2. Tracks in separate files
; 3. Same type tracks in one file
; 4. One contiguous image file
FileOption=2
ISOTrackSectorSize=2048



ISOTrackBlockingFactor=4
ISOTrackWithPregapPostgap=FALSE
XATrackSectorSize=2336
XATrackBlockingFactor=6
XATrackWithPregapPostgap=FALSE
DATrackWithPause=FALSE
ScramblingFor2352Sectors=FALSE
WriteIdentTxtOnTape=FALSE
VerifyAfterWrite=FALSE
;
; Selection of tape interface used. Supported are:
; 0) Null device
; 1) Adaptec AHA-1540/AHA-1542 board (SCSI)
; 2) ASPI for DOS drive
; 3) ASPI for Windows drive
; 4) CD CAM driver 
TapeInterface=2
; IO address of Adaptec AHA-154XX board (for TapeInterface 1):
AdaptecIOAddress=230h
BufferSize=
NrOfBuffers=
; ASPI host adapter number (0-2) to use (for TapeInterface 2):
AspiHostAdapterNumber=0
; SCSI ID of tape unit (only necessary if multiple units):
TapeTargetID=4
;
;
[cdrecording]
;
UsePhysicalImageFiles=FALSE
WriteEnable=TRUE
MultiSession=TRUE
Speed=2
Fixation=TRUE
LinearVelocityLevel=2
NrOfWriters=1
EstimateBeforeWrite=TRUE
IncrementalWrite=FALSE
DiscAtOnce=FALSE
UseMediumChanger=TRUE
;
; Selection of CD-R interface used. Supported are:
; 0) Null device
; 1) Adaptec AHA-1540/AHA-1542 board (SCSI)
; 2) ASPI for DOS drive
; 3) ASPI for Windows drive
; 4) CD CAM driver
CDRInterface=2
; IO address of Adaptec AHA-154XX board (for CDRInterface 1):
AdaptecIOAddress=230h
BufferSize=
NrOfBuffers=
; ASPI host adapter number (0-2) to use (for CDRInterface 2):
AspiHostAdapterNumber=0
; SCSI ID of CD-R unit (only necessary if multiple units):



CDRTargetID=4
;
;end of GEAR.INI



GEAR for CD-Bridge and Electronic Book
Elektroson's GEAR offers you the possibility to develop your CD-BRIDGE or Electronic Book application 
in house. All Multi Media versions of GEAR allow you to generate a CD-BRIDGE or Electronic Book (EB) 
image and write it to CD-Recordable and/or premaster tape.

CD-Bridge
The following steps describe how to generate a CD-BRIDGE image with GEAR.

1. Determine the name of your CD-i application e.g. CDI_APPL

2. Determine the name of the subdirectory to contain your CD-i application. e.g. CDI

3. Edit the following entries of your GEAR.INI file so that they contain the following:
SystemIdentifier=CD-RTOS CD-BRIDGE
ApplicationIdentifier=CDI/CDI_APPL.

NOTE
The ApplicationIdentifier must not start with a slash (/) and must end with a dot (.).

4. Use the GEAR software and create a volume with a CD-ROM XA track.

5. Create the subdirectory for your CD-i application and load your CD-i application file in this 
directory. Make sure that the names of your directory and CD-i application match those specified 
in the GEAR.INI file.

The CD-BRIDGE specific part of the image generation process is now complete. You can now continue 
the image generation process as for any other application (do not use the CD-i directory anymore!).

The resulting image can be processed with GEAR as any other CD-ROM XA image.

Electronic book
The following steps describe how to generate an Electronic Book image with GEAR.

1. Edit the following entry of your GEAR.INI file so that it contains 'ApplicationUse=EBxxx', where 
xxx stands for the language which will be used when the EB application starts. EB111 (for 
english) is most commonly used.

2. Use the GEAR software and create a volume with a CD-ROM XA track.

3. Load all of the files and directories associated with your EB application.

The resulting image can now be processed with GEAR as any other CD-ROM XA image.

NOTE
Elektroson can also do the Electronic Book specific indexing for you. Contact us for more information 
about our EB services.



Sense Codes (Hardware Troubleshooting when Writing to 
CD-R)
Additional sense codes provide a precise indication of the errors encountered while writing a CD-R disc. 

02H NO SEEK COMPLETE

03H CADDY OUT
Indicates that the drive's caddy is out.

04H DRIVE NOT READY
Indicates that the drive is temporarily unable to perform the desired operation.

06H NO INITIAL POSITION

08H COMMUNICATION FAILURE
Indicates that a communication error between the SCSI controller and the servo controller prevented the 
command from being performed (Hardware error).

09H TRACK FOLLOWING ERROR
Indicates that focusing or radial tracking did not succeed (Hardware error).

11H UNRECOVERED READ ERROR
Indicates that the previous read command failed, probably due to a flaw in the disc (Medium error).

12H MODE 0 ERROR
Medium error.

14H BLOCK NOT FOUND
Medium error.

15H POSITIONING ERROR
Indicates that a seek to a requested location on disc failed (Hardware error).

17H RECOVERED READ DATA WITH RETRIES
Indicates that the previous read command required data recovery which was accomplished by additional 
read operations (Recovered error).

18H RECOVERED READ DATA WITH ECC CORRECTION
Indicates that the previous read command required data recovery which was accomplished using Error 
Correction Code (ECC) correction (Recovered error).

1AH PARAMETER LIST LENGTH ERROR

20H INVALID COMMAND
The previous SCSI command is not supported by the device.

21H INVALID BLOCK ADDRESS
Indicates that one or more of the block addresses requested by the last read, write, seek or verify 
command extends beyond the end of the disc.

22H ILLEGAL FUNCTION



24H ILLEGAL FIELD IN COMMAND DESCRIPTOR
Indicates that one or more of the reserved bits in the command descriptor was set, or an option was 
selected that is not supported by the unit.

25H INVALID LUN
Indicates that the logical unit field of the command descriptor was not zero.

26H INVALID FIELD PARAMETER LIST
Indicates that the parameter list contained one or more of the reserved bits set to 1, or an option was 
selected that is not supported by the unit.

28H MEDIUM CHANGED
Indicates that the disc may have been changed since the last command issued by this initiator.

29H POWER-ON RESET OR BUS-RESET OCCURRED
Indicates that a power on reset or a bus reset has occurred since the last command issued by this 
initiator.

2AH MODE SELECT PARAMETER CHANGED

2CH COMMAND SEQUENCE ERROR
Indicates that the previous command is not allowed in the sequence.

31H MEDIUM FORMAT CORRUPTED
Indicates that the drive could not read (write) the requested information from (to) disc due to a corrupted 
or unknown format (Medium error).

32H WRITE DATA ERROR WITH CU
Indicates that a CU (uncorrectable) error occurred in the recorded data and was detected by monitoring 
the data writing operation through the RED level decoder (Hardware error).

33H MONITOR ATIP ERROR
Indicates that the drive could not read the ATIP code from the disc probably because of dust or shock 
(Medium error).

34H ABSORPTION CONTROL ERROR
Indicates that an error might have occurred while recording the data due to laser power clipping (Medium 
error).

3AH MEDIUM NOT PRESENT
Indicates that there is no disc mounted in the drive.

3DH INVALID BITS IN IDENTIFY MESSAGE
Indicates that the identify message is corrupted.

40H DIAGNOSTIC FAILURE
Indicates that a device self-test failed (Hardware error).

42H POWER-ON OR SELF TEST FAILURE
Indicates that a power on or self test sequence failed (Hardware error).

44H INTERNAL CONTROLLER ERROR



Indicates that the controller detected an error which could not be otherwise explained (Hardware error).

47H SCSI PARITY ERROR
Indicates that the controller detected a parity error.

48H INITIATOR DETECT ERROR
Indicates that the initiator detected an error.

50H WRITE APPEND ERROR
Indicates that an append by a write command during writing failed.

53H MEDIUM LOAD OR EJECT FAILED
Indicates that loading or unloading of the disc failed (Hardware error).

57H UNABLE TO READ TOC, PMA OR SUBCODE
Indicates that the drive was unable to read the TOC, PMA or subcode of the current disc (Medium error).

5AH OPERATOR MEDIUM REMOVAL REQUEST
Indicates that the operator requested to unload the disc.

63H END OF USER AREA ENCOUNTERED ON THIS TRACK
Indicates that the requested block exceeds the current track.

64H ILLEGAL MODE FOR THIS TRACK
Indicates that the data on the track is not according to the mode which is requested by the command.

65H VERIFY FAILED
Indicates that verification was not successful.

80H PROM ERROR
Indicates that the controller detected a PROM error.

81H ILLEGAL TRACK
Indicates that the track being accessed does not exist.

82H COMMAND NOT VALID NOW
Indicates that the command is not valid for the current host.

83H MEDIUM REMOVAL IS PREVENTED

A0H STOPPED ON NON DATA BLOCK
During reading data transfer stopped because you are attempting to read a block that is not a data block.

A1H INVALID START ADDRESS

A2H ATTEMPT TO CROSS TRACK BOUNDARY
A transfer length created by a write track command does not match the free space length in the track.

A3H ILLEGAL MEDIUM
The medium is not a Write Once disc.

A4H DISC WRITE PROTECTED



A5H APPLICATION CODE CONFLICT
The disc application code does not match the host application code.

A6H ILLEGAL BLOCK SIZE FOR COMMAND
Selected block size is not allowed for this command.

A7H BLOCK SIZE CONFLICT
Selected block size caused a mode conflict.

A8H ILLEGAL TRANSFER LENGTH
Indicates that the transfer length in the command descriptor block would cause an overflow of the write 
buffer.

A9H REQUEST FOR FIXATION FAILED
Fixation failed due to existing blank areas on disc.

AAH END OF MEDIUM REACHED
Indicates that during writing the end of the medium is detected, or the number of tracks reached the limit 
of 99, or the OPC area is full, or the PMA is full.

ABH ILLEGAL TRACK NUMBER
Indicates an invalid track number in the command descriptor block.

ACH DATA TRACK LENGTH ERROR
Indicates that the track length is invalid because not enough blocks were sent to the unit to meet the 
minimum track length of 300 blocks.

ADH BUFFER UNDER RUN
Indicates that the write action stopped because the cache buffer emptied.

AEH ILLEGAL TRACK MODE
Indicates that the selected track mode is not valid.

AFH OPTIMUM POWER CALIBRATION OPC ERROR
Indicates that power calibration failed. This could indicate a bad medium, laser failure or drive failure.

B0H CALIBRATION AREA ALMOST FULL
Indicates that only a few optimum power calibration areas are left.

B1H CURRENT PROGRAM AREA EMPTY
Indicates that the command could not be executed due to an empty program area.

B2H NO EFM AT SEARCH ADDRESS
Indicates that during reading or play back request no EFM was present.

B3H LINK AREA ENCOUNTERED
Indicates that during reading the link area was encountered.

B4H CALIBRATION AREA FULL
Indicates that the calibration area is full. This means that no more information can be written to the disc.

B5H DUMMY BLOCKS ADDED
Indicates that during writing, dummy blocks were added to meet the disc specification.



B6H BLOCK SIZE FORMAT CONFLICT
Indicates that during writing a block (with subheader) was received and a conflict was detected between 
the form bit of the header and the block size.

B7H CURRENT COMMAND ABORTED
Indicates that the current command has been aborted due to an abort command received.

C1H BARCODE READING ERROR
Indicates that an error occurred during barcode reading (Medium error).

D0H RECOVERY NEEDED
During power up the unit has detected that the device was writing during the last power down. The 
medium format can be corrupted.

D1H CAN'T RECOVER FROM TRACK
Indicates that the recovery of a corrupted track failed (Medium error).

D2H CAN'T RECOVER FROM PROGRAM MEMORY AREA
Indicates that the recovery of a corrupted program memory area failed (Medium error).

D3H CAN'T RECOVER FROM LEADIN AREA
Indicates that the recovery of a corrupted leadin area failed (Medium error).

D4H CAN'T RECOVER FROM LEADOUT AREA
Indicates that the recovery of a corrupted leadout area failed (Medium error).

D5H CAN'T RECOVER FROM OPTICAL POWER CALIBRATION AREA
Indicates that the recovery of a corrupted optical power calibration area failed (Medium error).

D6H EEPROM FAILURE
Indicates that the non volatile memory failed (Hardware error).
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GEAR Commands
GEAR commands can be inserted in a batch file or as a single command line. GEAR can be controlled by
these commands. The following sections describe all valid commands. The syntax of the commands is:

COMMAND_NAME <Y|N> <parameter> [optional]

A parameter enclosed in angular brackets must be specified. A parameter enclosed in square brackets is 
optional. The character '|' between parameters indicates that a selection between two or more parameters
has to be made.

- Special keys such as 'ESCAPE' or 'CARRIAGE RETURN' are abbreviated and enclosed in
angular brackets; for example: <ESC>, <RETURN>.

When the a parameter isn't specified GEAR will ask for the missing parameter. The default value (if any) 
is shown between brackets and is selected by pressing <ENTER>. This is also the case when extra 
information is required. A command can be interrupted by pressing <ESC>. Sometimes it will take time 
before GEAR stops executing the command. This is because commands require 'cleaning up' time.

Any of the following commands can be used.

1.General Commands

BATCH <file_name>

Starts executing commands from the given batch file. Refer to section 6.2 for more information.

EXIT

Ends the current session of the GEAR module.

HELP [<cmd>]

Provides information about the command. Entering an invalid command name or no command name 
results in a list of all available commands.

LOG <file_name>

Starts or stops the logging of session information in a given file. When logging is started for the first time 
the user has to specify the name of a file in which the information has to be stored. Refer to section 6.1 
for more information.

VDIR

An overview of all volumes present is given. The overview consists of:
-The volume name
-The volume size
-The session number
-The number of tracks within the volume
-The type of the volume
-The status of the volume
-The date and time of creation

For a plain ISO-9660 volume the number of tracks is always 1 and the type is always 'ISO'. Multi Media 



(MM) volumes allow you to create additional tracks and different types of volumes. The session number is
always 1 for volumes created with the NEWVOL command. Only volumes which are created with the 
SESSION command can have a session number greater than 1. The status of a volume can be either 
'Selected' or 'Closed'. A volume is 'Selected' if it is currently used otherwise the status of a volume is 
'Closed'. The date and time of creation of a volume is determined by using the time zone (TZ) 
environment variable. If you do not specify this variable the date and time is shown for the Pacific time 
zone (PDT).

TDIR

An overview of all tracks present in the current selected volume is given. The overview consists of:

-The track number
-The track size
-The type of the track
-The status of the track
-The date and time of creation

The type of a track can be XA, DA or ISO. The status of a track can be either 'Selected' or 'Closed'. A 
track is 'Selected' if it is open for copying data to it, otherwise the status of a track is 'Closed'. The date 
and time of creation of a track is determined by using the time zone (TZ) environment variable. If you do 
not specify this variable the date and time is shown for the Pacific time zone (PDT).

2.Formatting Commands

The formatting commands are used to do CD-ROM file formatting. A variety of commands is available to 
generate an empty image and to add, delete or change files and directories in it. 

All general commands, as specified above, plus the following are valid:

-volume related commands are valid
-track related commands
-directory and file related commands
-Multi Media related commands
-miscellaneous commands

Volume Related Commands

NEWVOL <vol_name> <80|74|63|18>

Creates a new empty virtual volume with the given name. The new volume is automatically selected. The 
name may not contain other characters than uppercase A..Z, digits 0..9 and underscore '_' (refer to 
Appendix A). The name can be 8 characters long. If you want to give your volume a longer name, you can
use the PRIMVD command to rename the Volume Identifier. Refer to section 5.4 for more information.

SELVOL <vol_name>

Selects an existing volume for use. The previously selected volume (if any) is closed and the given 
volume is selected. A volume must be selected before you can edit the contents of a volume. Refer to 
section 5.1 for more information.

SESSION <session_nr>

The SESSION command is used to append data to a multi-session disc. Refer to section 5.6 for more 



information. 

PRIMVD

This command allows editing of settings in the Volume Descriptor.
The following settings can be changed:

-VolumeIdentifier
-SystemIdentifier
-PublisherIdentifier
-DataPreparerIdentifier
-ApplicationIdentifier
-ApplicationUse
-CopyRightIdentifier
-AbstractFileIdentifier
-BibliographicIdentifier

The default values specified in the GEAR.INI file can be changed using the EDITPREFS command. Refer
to section 5.4 for more information.

EDITVOL

This command allows editing of the Generator Setup settings used during the creation of a volume. The 
following settings can be changed:

-NonIsoNameHandling
-Hidden option
-Startsector option
-Archive option
-Maximum directory nesting level

The default values specified in the GEAR.INI file can be changed using the EDITPREFS command. Refer
to section 10.1 for more information.

PHYSVOL

Creates the physical image files for the selected volume. For each track in the image a physical image file
is created. It is also possible to use the PHYSTRK command for creating physical image files. Refer to 
section 7.2 for more information.

VERVOL

Verifies the virtual image of the selected volume. Refer to section 7.1 for more information.

DELVOL <vol_name>

Deletes the specified virtual volume. Refer to section 5.1 for more information.

Track Related Commands

SELTRK <track_nr>

Selects an existing track for use. The previously selected track (if any) is minimized and closed, and the 
given track is selected. Refer to section 5.2 for more information.

NEWTRK <ISO|XA|DA> [<track_nr>]

Creates a new empty virtual track with of the chosen type. The new track is automatically selected. Refer 



to section 5.2 for more information.

PHYSTRK [<file_name>]

Creates a physical image file of the selected track. If the optional parameter <file_name> is specified the 
image will be written to this directory and not the working directory (e.g. use PHYSTRK D:\IMAGES\
IMAGE1). GEAR will automatically find the physical image when necessary (e.g when using the physical 
image for the WRITE command). Refer to section 7.2 for more information.

VERTRK

Verifies the virtual image of the selected track. Refer to section 7.1 for more information.

DELTRK <track_nr>

Deletes the specified virtual track. Refer to section 5.2 for more information.

Directory and File Related Commands

CD <dir_name>

Changes to the specified directory of the virtual image. The command recognizes 'DOS' commands like 
'CD ..' , 'CD \' and 'CD \SUB1'. It is possible to specify a path name for the new directory. Refer to section 
5.3 for more information.

NEWDIR <dir_name>

Creates a new directory on the virtual image. It is possible to create hidden directories by setting the 
HIDDEN option to TRUE before creating the new directory (refer to the EDITPREFS command). Refer to 
section 5.3 for more information. 

DELDIR <dir_name>

Deletes the specified directory in the virtual image. Wildcards are not allowed. A directory must be empty 
before it can be deleted. Complete directories can be deleted by using the DELTREE command. Refer to 
section 5.3 for more information.

COPY <file_spec>

Copies the specified data file(s) to the virtual image. Wildcards are allowed. Refer to section 4.3 for more 
information.

It is possible to specify the exact location (sector number) for the file(s). This can be achieved by 
switching the SECTOR option on. GEAR will ask for the start location of each file to be loaded (see 
EDITPREFS command).

Files can also be hidden by setting the HIDDEN option to TRUE (see EDITPREFS command) before 
copying the files. The hidden setting cannot be changed afterwards; the only solution is to delete the 
file(s), reset the HIDDEN setting and reload the file(s).

COPYTREE <os_dir_tree> [<cd_dir>]

Copies a complete directory tree to the virtual image. All files and subdirectories of the specified tree are 
automatically loaded. Subdirectories are created in the image if necessary. After completion the virtual 



image contains an exact copy of the tree specified. The target directory specifies where in the virtual 
image the OS directory will be loaded. The software will create as much space as necessary for each 
directory in the specified tree. The maximum number of nested directories under ISO is 8.

RENAME <old_name> <new_name>

Renames a directory or file in the virtual volume to the new name.    Wildcards are not allowed. Refer to 
section 5.3 for more information.

DELETE <file_spec>

Deletes the specified file(s) from the virtual image. Files can be specified by their complete name i.e. 
including the version number. Wildcards are allowed e.g. *.*;* will delete all files in the current directory of 
the virtual image. If files with non ISO names have been loaded, the version number can be omitted. 
Refer to section 5.3 for more information.

DELTREE <dir_tree>

Deletes the specified ISO tree from the virtual image. The specified directory and all subdirectories are 
deleted. Wildcards are not allowed. Refer to section 5.3 for more information.

Multi Media Related Commands

These commands can only be used if an XA track is selected.

COPYMMF <file_spec><mmtype><chnr><int_fac><tot_fac>[<EOR|TRG>]

Copies the specified Multi Media file(s) to the virtual XA track. Refer to section 9.2 for more information. 
The following parameters must be specified:

mmtypeMulti Media type; specifies the type of each file that is loaded.

chnr Channel number; specifies the channel number for each file that is loaded.

int_fac Interleave factor; specifies the interleave factor for each file that is loaded. Refer to
tot_fac for an explanation.

tot_fac Total interleave factor; specifies the total interleave factor of each file that is loaded. This
number together with the interleave data factor determines the interleaving of each file.

EOR End of record; specifies if the End Of Record bit should be set in the subheader of the
last sector of each file that is loaded. This can be specified together with the TRG
parameter.

TRG Trigger; specifies if the TRiGger bit should be set in the subheader of the last sector of
each file that is loaded. This can be specified together with the EOR parameter.

More information about the use of these parameters for CD-ROM XA applications can be obtained from 
the CD-ROM XA specification [4]. 

Usually it is easier to use the dedicated CD-ROM XA interleaver tools (like the Mammoth Tool Set) for 
creating these files and use the GEAR COPYXA command to load pre-interleaved Multi Media files.

COPYXA <file_spec> 



Copies the specified files as pre-interleaved files to the image. Refer to section 9.2 for more information. 

Miscellaneous Commands

EDITPREFS

This command can be used to change the generator settings. Some of these settings can also be 
changed with the PRIMVD command. The difference is that the EDITPREFS command changes the 
contents of the GEAR.INI file, while the PRIMVD command changes the settings for the selected volume. 
Settings in the GEAR.INI file are used for each new volume. The PRIMVD settings are for the selected 
Volume only. Refer to section 9.1 for more information.

FREE

Shows the amount of free space (bytes) on the selected virtual volume. This command can take some 
time if you have a large volume with a lot of empty space.

DIR [<dir_name>] [/P] [/S]

Shows all the files and directories present in the current or specified directory of the selected track. If 
dir_name is not specified the current directory will be shown.

For each entry the following is shown:
-Name
-Directory (<DIR>) if it's a directory
-Hidden (H) or normal (n) entry
-Startsector of file
-Time and date of entry
-Size in bytes

The /S option can be used to display the contents of the subdirectories. The /P option can be used to 
generate a printout. The total number of files listed displayed at the end of the printout.

3.CD-R Commands

The CD-R commands are used when writing a volume to CD-R disc. 

MOVEMEDIUM <src_address><dest_address>

Moves a caddy/disc from one location (address) to another location (address) in the Jukebox. Storage 
slots are numbered from location 1 to 1000. Drivers (CD-Recorders and CD-Readers) are numbered from
location 1001 to 2000. The mailbox of the Jukebox has location number 2001. The gripper(s) (the device 
that actually moves the medium) is/are numbered 3001 and 3002.

WRITECD <volume_name> [<nrofcopies>]

Writes a GEAR volume to a CD-R disc. The number of copies parameter can be used to write multiple 
discs of the same volume. If a medium changer (supported by GEAR) is connected to the same SCSI bus
as the CD-Recorder, GEAR will use the medium changer to change the discs. Otherwise, the user is 
asked to do the medium change. Refer to section 7.4 for more information.

WRITECD <foreign_image_name|track_list_file_name> [<nrofcopies>] [X] [<type>]

This command is used when working with external volumes. The optional character X indicates that the 



specified name should be interpreted as a foreign image or track list file. Refer to section 5.5 for more 
information.

ESTIMATE <volume_name>

Checks the performance of your system for writing the selected GEAR volume to CD-R disc. Refer to 
section 7.3 for more information.

ESTIMATE <foreign_image_name|track_list_file_name> [X] [<type>]

Checks the performance of your system for writing the external volume to CD-R disc. The optional 
character X indicates that the specified name should be interpreted as a foreign image or track list file. 
Refer to section 7.3 for more information.

DISCINFO

Displays information about the CD-R disc in the CD-Recorder. Refer to section 8.1 for more information.

SETUPCD

Defines the settings used when writing the CD-R disc and/or while estimating the performance. The 
following information can be specified:

-Use the physical image file (Yes or No)
-Write a multi session CD-R (Yes or No)
-Use the test mode of the CD-Recorder (Yes or No)
-Write a CD-R disc with 1x, 2x or 4x speed (1, 2 or 4)
-Fixate the CD-R after writing (Yes or No)
-Linear velocity used for writing (1, 2 or 3)
-Number of CD-Recorders which should be addressed (1 up to 32).

The setup information is saved in the GEAR.INI file. You can either edit the GEAR.INI file directly or 
(preferably) use the SETUP command to change the settings. Refer to section 10.2 for more information.

FIXATION

Checks the disc currently loaded. If the disc is not already fixated it will fixate the disc. This command can
be used in combination with 'track at once' CD-Rs. All tracks can be written separately to the CD-R with 
the 'Fixation' entry in the GEAR.INI file set to FALSE. The tracks can then be fixated using this command. 
Refer to section 10.3 for more information.

Warning
If an image is not fixated it cannot be read on a CD-ROM player!

READTRACK <nr> <file>

Reads all of the sectors of the specified track from the CD-R disc and saves them in the specified file. The
amount of information read depends on the track type. This command will automatically determine the 
track type, the track size and the start position of the track and will then start copying. For ISO tracks 
(mode 1) 2048 bytes will be read per sector. For CD-ROM XA and CD-i (mode 2) 2336 bytes will be read 
per sector and for CD Digital Audio 2352 bytes will be read per sector. Not all CD-Recorders support the 
reading of CD Digital Audio tracks and/or CD-i tracks!

Files created with this command can be written to a CD-R disc again as external image files!



LISTCD

Shows the selected setup settings which are used for estimating and writing.

4.Premaster Tape

The premaster tape commands are used when writing a volume to premaster tape.

WRITETP <volume_name>

Writes the GEAR volume to premaster tape. Refer to section 7.5 for more information.

WRITETP <foreign_image_name|track_list_file_name> [X] [<type>]

This command is used when working with external volumes. The optional character X indicates that the 
specified name should be interpreted as a foreign image or track list file. Refer to section 5.5 for more 
information.

VERIFY <volume_name>

Verifies the volume by comparing it to the volume on tape. Before the verification GEAR asks if the 
current setup values should be used or if they should be changed. The setup values determine whether 
the virtual volume or the physical image file is used for verification. The setup values must be the same as
those used for writing the tape.

VERIFY <foreign_image_name|track_list_file_name> [X] [<type>]

This command is used when working with external volumes. The optional character X indicates the 
specified name should be interpreted as a foreign image or track list file. All setup values are used except 
for the value that determines whether the virtual image or the physical image file is used. The file is 
interpreted as a physical CD-ROM image file or as a track list file which specifies multiple image files (see
WRITE command).

SETUPTP

Defines the setup values which are used while writing the premaster tape and/or while verifying the tape.

In general it is sufficient to use the default values as specified in the supplied GEAR.INI file (refer to 
Appendix C). The setup information is saved in the GEAR.INI file. You can either edit the GEAR.INI file 
directly or use (preferably) the SETUP command to change these values. Refer to section 10.3 for more 
information.

LISTTP

Shows the selected setup values which are used for verification and writing.



A CD-ROM based system in the same market segment as CD-i. Based on a Risc processor for optimum 
graphical performance



The time a CD-ROM drive or harddisk needs to read and transfer the requested data from disc to the 
target computer



A method of compressed audio data storage; instead of storing the signal, the difference between signals 
is stored. This means that only 4 bits are needed per sample rather than the normal 16 bits.

For CD-i, levels A, B, and C are recognized. B and C are also used in CD-ROM XA. The sample 
frequencies used to measure the audio signal are 37.8 kHz and 18.9 kHz for levels B and C respectively. 
This brings the band width (the maximum frequency to be produced) to 17 kHz and 8.5 kHz. For level A 
these figures are 44.1 kHz and 20 kHz. Using ADPCM, a 16-fold reduction in storage requirements can 
be achieved (Level C, mono)



Working method for modelling (new) information. Examples of authoring systems are word processors 
and spreadsheets on the PC, as well as Multi Media workstations for combining sound, video, images and
text for real-time audiovisual presentations.



The smallest unit of information. Bit is a contraction of "binary" and "digit". A binary digit has the value of 
"0" or "1"



A symbol or character, consisting of 8 bits.



A system for presenting information (text, images and video) on a television screen. The standard is 
defined by Philips and Sony and is described in the Green Book.



Based on audio CD technology, CD-ROM is a storage medium which can only be read.



XA stands for Exended Architecture and is standard for CD-ROM in which a number of options from CD-i 
have been added. These include audio compression (ADPCM), multi-channel audio (max. 16), file 
interleaving, user data (2336 bytes/sector), image compression etc. A CD-ROM XA disc is a Mode 2 disc 
in which the data is located in Form 1 (2048 bytes/sector) or Form 2 (2336 bytes/sector) sectors.



A 4mm tape format also used for data storage.



DDP is a CD sector level protocol designed to adequately describe a compact disc. A compact disc 
described using DDP can be reliably mastered. Some mastering and replication companies prefer the 
premastering tape with DDP protocol



CD-ROM oly uses 2048 bytes of a sector of 2352 bytes for data storage. Header and synchronization 
information uses 12 and 4 bytes respectively. The remaining 288 bytes are used for ECC (Error 
Correction Code) and EDC (Error Detection Code) information. This information is used by the drive 
hardware to detect and correct data errors caused by scratches or dirt on the disc and thereby optimizing 
data integrity.



Form 1 is a sub-format of Mode 2. It defines the structure of the CD-ROM sector as follows: sync (12 
bytes), header (4 bytes), subheader (8 bytes), data (2048 byte), EDC (4 bytes), ECC (276 bytes), This 
layout is used for normal data files (incl. Photo CD and Electronic Book).



Form 2 is a sub format of Mode 2. It defines the structure of the CD-ROM sector as follows: sync (12 
bytes), header (4 bytes), subheader (8 bytes), data (2324 bytes), and 4 bytes reserved or for EDC. This 
layout is used for files where error correction is pointless or impossible due to their real-time character i.e.
compressed audio or moving images.



The Hierarchial File System is used by Apple floppy's, hard disks and for CD-ROM. Apple also supports 
the ISO-9660 standard.



The international standard defining the CD-ROM data format. Tha aims of the standard are to achieve 
interchangeability of discs and to optimize performance. It is the official standard that all CD-ROM 
applications should conform to. GEAR of course meets this standard!



The process in which the Glass Master is produced for production of the Stampers which in turn are used 
for replication of the CD's. The glass master contains photosensitive lacquer which is illuminated on a 
Laser Beam Recorder (LBR). The data for mastering comes from a premaster tape.



Defines the structure of the CD-ROM sector as follows: sync (12 bytes), header (4 bytes), data (2048 
bytes), reserved (8 bytes), ECC (276 bytes), and EDC (4 bytes).



Defines the structure of the CD-ROM sector as follows: sync (12 bytes), header (4 bytes), subheader (8 
bytes), remainder (2312 bytes) dependent on the chosen form (1 or 2)



The actual bit-to-bit copy of the future CD-ROM disc, without ECC and EDC information. Usually a 
physical image can be as large as 660 Mb and thus demands a lot of hard disk space (all data will be 
present in the original files, and once more in the image file). If an image consists of multiple tracks, a 
seperate image file is created for each track. However, GEAR allows the user to make an application 
without the need for so much hard disk space by using a virtual image which is just an administration of 
the image structure.



The Small Computer Standard Interface is an industry standard for the interface between computers and 
peripherals.



Making a CD-ROM image usually requires an exceptional amount of hard disk space as all data is 
present in the original files and duplicated in the CD-ROM image. GEAR allows the user to make an 
application without the need for so much hard disk space by producing a virtual image which is just an 
administration of the image structure. The software keeps record of the files to be present in the final 
application. Simulation and writing of the final premaster tape or CD-Recordable is done using this 
volume administration, thereby eliminating the need for a lot of expensive hard disk capacity.
A CD-ROM can contain multiple tracks in which case multiple virtual tracks are created which means that 
for every track of the CD-ROM an administration is kept.
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Pressing this button will select the previous slot.



Pressing this button will select the next slot.



This control shows which slot has been selected. The bar under the didgets shows whether
the slot is occupied or not. Clicking on one of the didgets will increment the didget by one.



Pressing this button will move the disc loaded in the selected drive or gripper to the selected slot.



Pressing this button will move the disc loaded in the selected slot to the selected drive or gripper.



Pressing this button will select the previous drive or gripper (if any) in the list.



Pressing this button will select the next drive or gripper (if any) in the list.



This control shows which drive or gripper has been selected. The bar under the icon shows whether
the drive is occupied or not.



Pressing this button will insert a disc into the system. This will only work when an unoccupied gripper is 
selected.



Pressing this button will eject a disc from the system. This will only work when an occupied gripper is 
selceted.






